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Module |

Introduction: GIS, RS, GPS

In this module:

e What is Geographic Information Systems (GIS)
e Component of GIS

¢ GIS Setup

¢ Vector vs Raster

* Remote Sensing (RS)

¢ Global Positioning System (GPS)

4 Comprehensive Disaster Management Programme (CDMP 1l), DMRD, MoFDM



ArcGIS Basic

What is GIS?

“In the strictest sense, a GIS is a computer system capable of assembling, storing, manipulating, and
displaying geographically referenced information, i.e. data identified according to their locations.
Practitioners also regard the total GIS as including operating personnel and the data that go into the
system.” USGS

A geographic information system (GIS) is a computer-based tool for mapping and analyzing things that
exist and events that happen on earth. GIS technology integrates common database operations such as
query and statistical analysis with the unique visualization and geographic analysis benefits offered by
maps.” ESRI

“GIS is an integrated system of computer hardware, software, and trained personnel linking
topographic, demographic, utility, facility, image and other resource data that is geographically
referenced.” NASA

Therefore, a geographic information system (GIS) integrates hardware, software, and data for
capturing, managing, analyzing, and displaying all forms of geographically referenced information. GIS
allows us to view, understand, question, interpret, and visualize data in many ways that reveal
relationships, patterns, and trends in the form of maps, globes, reports, and charts. A GIS helps you
answer questions and solve problems by looking at your data in a way that is quickly understood and
easily shared.

GIS is a technological field that incorporates geographical features with tabular data in order to map,
analyze, and assess real-world problems. The key word to this technology is Geography — this means
that some portion of the data is spatial, in other words, data that is in some way referenced to locations
on the earth. Coupled with this data is usually tabular data known as attribute data. Attribute data can
be generally defined as additional information about each of the spatial features. An example of this
would be schools. The actual location of the schools is the spatial data. Additional data such as the
school name, level of education taught, student capacity would make up the attribute data. It is the
partnership of these two data types that enables GIS to be such an effective problem solving tool
through spatial analysis.

GIS operates on many levels. On the most basic level, GIS is used as computer cartography, i.e.
mapping. The real power in GIS is through using spatial and statistical methods to analyze attribute and
geographic information. The end result of the analysis can be derivative information, interpolated
information or prioritized information.
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Components of GIS

Hardware

Hardware: comprises the equipment needed to support the many activities of GIS ranging from data
collection to data analysis. The central piece of equipment is the workstation, which runs the GIS
software and is the attachment point for ancillary equipment. Data collection efforts can also require
the use of a digitizer/Scanner for conversion of hard copy data to digital data and a GPS data logger to
collect data in the field. Plotter can be used for printing wide format Maps.

Software: is important for GIS. Application software is essential for GIS for creating, editing and
analyzing spatial and attributes data. To perform some special GIS processing needs extra software,
which comes as extension. There is also web GIS software that helps serve data through Internet
browsers.

Data: the core of any GIS. There are two primary types of data that are used in GIS. A geodatabase is a
database that is in some way referenced to locations on the earth. Geodatabases are grouped into two
different types: vector and raster. Vector data is spatial data represented as points, lines and polygons.
Raster data is cell-based data such as aerial imagery and digital elevation models. Coupled with this
data is usually data known as attribute data. Attribute data generally defined as additional
information about each spatial feature housed in tabular format. Documentation of GIS datasets is
known as metadata. Metadata contains such information as the coordinate system, when the data was
created, when it was last updated, who created it and how to contact them and definitions for any of
the code attribute data.

People: Well-trained people knowledgeable in spatial analysis and skilled in using GIS software are
essential to the GIS process. These can be analyst, programmer and operator
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Raster and vector are two very different but
common data formats used to store geospatial
data.

Vector data use X and Y coordinates to define the
locations of points, lines, and areas (polygons)
that correspond to map features such as schools,
roads, and parcels. As such, vector data tend to
define centers and edges of features.

Raster data, on the other hand, use a matrix of
square areas to define where features are
located. These squares, also called pixels, cells,
and grids, typically are of uniform size, and their
size determines the detail that can be maintained
in the dataset. Because raster data represent
square areas, they describe interiors rather than
boundaries as is the case with vector data.

Vector data are excellent for capturing and
storing spatial details, while raster data are well
suited for capturing, storing, and analyzing data
such as elevation, temperature, etc. that vary
continuously from location to location. Raster
data formats also are used to store aerial and
satellite imagery.
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Concept of Layers
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Data capturing for GIS

There are many sources for data capturing to feed into GIS. Here two options will be discussed very
briefly
(a) Remote Sensing (RS) datasets; (b) Global Positioning System (GPS)

What is Remote Sensing (RS)

Remote Sensing is the science and art of acquiring information (spectral, spatial, and temporal) about
objects, area, or phenomenon, without coming into physical contact with the objects, or area, or
phenomenon under investigation. Without direct contact, some means of transferring information
through space must be utilized.

Here are two main types of remote sensing: passive remote sensing and active remote sensing. Passive
sensors detect natural radiation that is emitted or reflected by the object or surrounding area being
observed. Reflected sunlight is the most common source of radiation measured by passive sensors.
Examples of passive remote sensors include film photography, infrared, charge-coupled devices, and
radiometers. Active collection, on the other hand, emits energy in order to scan objects and areas
whereupon a sensor then detects and measures the radiation that is reflected or backscattered from the
target. RADAR is an example of active remote sensing where the time delay between emission and
return is measured, establishing the location, height, speeds and direction of an object.

By satellite, aircraft, spacecraft images, data is created to analyze and compare things like vegetation
rates, erosion, pollution, forestry, weather, and land use. These things can be mapped, imaged, tracked
and observed. The process of remote sensing is also helpful for city planning, archaeological
investigations, military observation and geomorphological surveying.

Resolution (Spatial): Spatial resolution is a measure of the smallest object that can be resolved by the
sensor, or the linear dimension on the ground represented by each pixel or grid cell in the image
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Resolution (Temporal): Temporal Resolution is the frequency of flyovers by the satellite or plane which
refers to the length of time it takes for a satellite to complete one entire orbit cycle. The revisit period of
a satellite sensor is usually several days. Therefore the absolute temporal resolution of a remote sensing
system to image the exact same area at the same viewing angle a second time is equal to this period

What is Global Positioning System (GPS)

The Global Positioning System (GPS) is a space-based global navigation satellite system (GNSS) that
provides location and time information in all weather, anywhere on or near the Earth, where there is an
unobstructed line of sight to four or more GPS satellites. It is maintained by the United States
government and is freely accessible by anyone with a GPS receiver.

GPS was created and realized by the U.S. Department of Defense (USDOD) and was originally run with
24 satellites. It became fully operational in 1994,

In addition to GPS, other systems are in use or under development. The Russian GLObal NAvigation
Satellite System (GLONASS) was in use by only the Russian military, until it was made fully available to
civilians in 2007. There are also the planned Chinese Compass navigation system and the European
Union's Galileo positioning system.

Basic Concept of GPS

A GPS receiver calculates its position by precisely timing the signals sent by GPS satellites high above
the Earth. Each satellite continually transmits messages that include

o the time the message was transmitted
e precise orbital information (the ephemeris)
o the general system health and rough orbits of all GPS satellites (the almanac).

The receiver uses the messages it receives to determine the transit time of each message and computes
the distance to each satellite. These distances along with the satellites' locations are used with the
possible aid of trilateration, depending on which algorithm is used, to compute the position of the
receiver. This position is then displayed, perhaps with a moving map display or latitude and longitude;
elevation information may be included. Many GPS units show derived information such as direction and
speed, calculated from position changes.

Three satellites might seem enough to solve for position since space has three dimensions and a position
near the Earth's surface can be assumed. However, even a very small clock error multiplied by the very
large speed of light — the speed at which satellite signals propagate — results in a large positional error.
Therefore receivers use four or more satellites to solve for the receiver's location and time.

9 Comprehensive Disaster Management Programme (CDMP 1l), DMRD, MoFDM
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GPS Structure

The current GPS consists of three major segments. These are the space segment (SS), a control segment
(CS), and a user segment (US.). The U.S. Air Force develops, maintains, and operates the space and
control segments. GPS satellites broadcast signals from space and each GPS receiver uses these signals
to calculate its three-dimensional location (latitude, longitude, and altitude) and the current time.

The space segment is composed of 24 to 32 satellites in medium Earth orbit. The control segment is
composed of a master control station, an alternate master control station, and a host of dedicated and
shared ground antennas and monitor stations. The user segment is composed of hundreds of thousands
of U.S. and allied military users of the secure GPS Precise Positioning Service and tens of millions of
civil, commercial, and scientific users of the Standard Positioning Service.

Space Segment: The space segment (SS) is composed
of the orbiting GPS satellites or Space Vehicles (SV)
in GPS parlance. There are six orbits with four
satellites each. The six orbits have approximately 55°
inclination (tilt relative to Earth's equator) The orbits
are arranged so that at least six satellites are always
within line of sight from almost everywhere on
Earth's surface. In general terms, the angular
difference between satellites in each orbit is 30, 105,
120, and 105 degrees apart which, of course, sum to
360 degrees.

Orbiting at an altitude of approximately 20,200 km
(12,600 mi); orbital radius of approximately
26,600 km (16,500 mi).

Control Segment: The control segment is composed
of

a master control station (MCS),

an alternate master control station,
four dedicated ground antennas and
six dedicated monitor stations

ARWNR

The flight paths of the satellites are tracked by
dedicated U.S. Air Force monitoring stations in
Hawaii, Kwajalein, Ascension Island, Diego Garcia,
Colorado Springs, Colorado and Cape Canaveral
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GPS Applications

e New data capturing

e Navigation

e Vehicle Tracking System
e Geo-referencing etc

ArcGIS Basic

User Segment: In general, GPS receivers are
composed of an antenna, tuned to the frequencies
transmitted by the satellites, receiver-processors, and
a highly stable clock (often a crystal oscillator). They
may also include a display for providing location and
speed information to the user. A receiver is often
described by its number of channels: this signifies
how many satellites it can monitor simultaneously.
Originally limited to four or five, this has
progressively increased over the years so that, as of
2007, receivers typically have between 12 and
20 channels
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Module lI

ArcMap Basics (ArcGIS)

As it implies, ArcMap is used to make maps. It is a
map-centric software application. In ArcMap, a map
document (.mxd) is how a map is stored, shared,
and managed on your computer. This map
document contains not only the traditional
cartographic elements of a map, but also the
environment, or user interface, you use to work with
that map. ArcMap is where you can perform your
spatial analysis and querying along with editing, 3D
analysis, data development, and display.

In this module:

e Starting ArcMap and opening a map

¢ Using the table of contents

¢ Data view and layout view

* Moving around the map

e Setting bookmarks

® Opening magnifier and overview windows

e Exploring data on a map

e Getting help

e Saving a map and exiting ArcMap
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Starting ArcMap from the Start menu

1. Click the Start button on the Windows
taskbar.

2. Point to Programs.

3. Point to ArcGIS.

4. Click ArcMap.

Starting ArcMap from ArcCatalog

1. Click the Launch ArcMap button on the
Standard toolbar
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Opening a Map from ArcMap

1. Click the Open button on the Standard

toolbar.
2. Click the Look in dropdown arrow and DE §| FANEE
navigate to the folder that contains the
map.
3. Click the map you want to open.
4. Click Open.
Lockre | 3 5 aree Mop Zl = B & o
TR bty

R anstomry Map.mnd 4] oreervies md
10U, msd P Lo mood

L
& | oricla. mard
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Opening a Map from ArcCatalog

1. Start ArcCatalog if it isn’t already running.
2. In ArcCatalog, navigate to the folder that
contains your map.

B BPX LR A ST WP | ]

3. Click the Thumbnails button to look at the B i ——————Rareio® =
maps the folder contains. fom S —— : :
4. Double-click the map to open it in ArcMap. e w

btbbbbtlnlﬂ
Q i-__
i L
} | ilF
L L

Table of Contents (TOC): Every map has a table of contents. It shows what layers the map contains
and also how the map presents the geographic features in those layers. Some maps display all the
layers in one data frame. Others, such as those with insets and overviews, will have more than one data
frame. The TOC shows how the layers are organized into data frames. When viewing a map, you’ll use
the TOC primarily to turn layers on and off. As you begin building your own maps, you’ll find that the
TOC is the focal point for many tasks, such as adding and deleting layers and determining how to draw
layers. You can choose to display the table of contents with the Display, Source, or Selection tabs.

The table of contents lists all the layers on the map and shows what the features in each layer
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represent. The check box next to each layer indicates whether it is currently turned on or off, that is,
whether it is currently drawn on the map or not. The order of layers within the table of contents is also
important; the layers at the top draw on top of those below them. Thus, you’ll put the layers that form
the background of your map, such as the ocean, at the bottom of the table of contents.

Layers in the table of contents can be further organized into data frames. A data frame simply groups,
in a separate frame, the layers that you want to display together. You always get a data frame when
you create a map; it’s listed at the top of the table of contents as “Layers”, but you can change the
name to something more meaningful if you like. For many of the maps you make, you won’t need to
think much more about data frames; you’ll just add layers to your map and, depending on how you
order them in the table of contents, some layers will draw on top of others. You will want to think more
about data frames—and adding additional ones—when you want to compare layers side by side or
create insets and overviews that highlight a particular location or attribute.

Showing the Table of Contents

1. Click Window on the Main menu.
2. Click Table Of Contents

Selection Tool ‘Window Help

[ E! ;o Overviaw
Magrifer

& AcToobox
Turning a Layer On or Off
1. In the table of contents, check the box next
to the layer’s name. CEEa R
CE—
The layer should appear on your map. If you —
can’t see the layer, it may be hidden by o
another layer or display only at a particular | LR
scale.
IL:::' L T A
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Showing a Layers LEGEND

1. Click the plus or minus sign to the left of the
layer name in the table of contents to show
or hide its legend.

Showing the content of a Data Frame

1. Click the plus or minus sign to the left of the
data frame in the table of contents to show
or hide the list of layers it contains.

e D e et et Jab B
DEWa n

Eerr ik T O A=
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Switching to Data View

1. Click the View menu on the Standard
toolbar.

2. Click Data View. The ArcMap window
displays the active data frame.
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Data View and Layout View: ArcMap provides two different ways to view a map: data view and
layout view. Each view lets you look at and interact with the map in a specific way. When you want to
browse the geographic data on your map, choose data view. Data view is an all-purpose view for
exploring, displaying, and querying the data on your map. This view hides all the map elements on the
layout—such as titles, North arrows, and scalebars— and lets you focus on the data in a single data
frame, for instance, to do editing or analysis. When you’re preparing your map to hang on the wall, put
in a report, or publish on the Web, you’ll want to work with it in layout view. Layout view is for laying
out your map. In layout view, you’ll see a virtual page upon which you can place and arrange map
elements. In layout view, you can do almost everything you can in data view, plus design your map.

Switching to Layout View

1. Click the View menu on the Standard
toolbar.

2. Click Layout View. The ArcMap window
displays the entire map
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X

HuN@E=FyoAn’
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You can also use these buttons to quickly switch
between the data and layout view
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Zooming in or out

Zooming to the full extent of the data

1. Click the Zoom In or Zoom Out button on
the Tools toolbar.
2. Move the mouse pointer over the map &

click once to zoom around a point. Or click

and drag a rectangle defining the area yo
want to zoom in or out on.

Use these buttons
to zoom in or out a

? fixed amount.

u

)

3. Click the Full Extent button on the Tools toolbar.

Panning

4. Click the Pan button on the Tools toolbar.
5. Move the mouse pointer over the map display and click
and drag the pointer.

DD IE RO M F

[ : | ]
| & 3% 2 O
o

Moving back or forward on display

Tools toolbar

6. Click the Back or Forward Extent buttons on the Tools toolbar.

Zooming to the extent of a layer

1. Right-click the layers you want to zoom to.

2. Click Zoom To Layer.
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Zooming to specific scale

1. Type the desired scale on the Standard

toolbar. = =
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Spatial Bookmark: A spatial bookmark identifies a particular geographic location that you want to
save and refer to later. For example, you might create a spatial bookmark that identifies a study area.
That way, as you pan and zoom around your map, you can easily return to the study area by accessing
the bookmark. You can also use spatial bookmarks to highlight areas on your map you want others to
see. You can create a spatial bookmark at any time. As a shortcut, you can also create bookmarks when
you find and identify map features. Spatial bookmarks, however, can only be defined on spatial data;
they can’t be defined on an area of the page in layout view. Each data frame on your map maintains its
own list of bookmarks. In layout view, the list reflects the bookmarks of the active data frame.

Creating a Spatial bookmark

1. Pan and zoom the map to the area for
which you want to create a bookmark.

2. Click the Bookmarks menu, and click Create.

3. Type a name for the bookmark.

4. Click OK.
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Using a Spatial bookmark

1. Click the Bookmarks menu, and click the
name of the bookmark you want to use.

Tl Ll T

=

The bookmarked display appears.

Creating spatial bookmark using Identify dialog box

1. Click the Identify button on the Tool ﬁ
toolbar. I
2. Click the mouse pointer over the map G

feature to identify. s

S j:
3. Right-click the identified feature in the
Identify Results dialog box. | S
.

4. Click Set Bookmark.

The bookmark is named after the feature.

Creating spatial book mark from Find dialog box

1. Click the Find button on the Tools toolbar.
2. Fill in the dialog box to find the features you o
want. Ll
3. Right-click the Value in the Find Results list. ::
4. Click Set Bookmark. onl©
&/ I T
The bookmark is named after the feature. Bl e e e [Ere=
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- - | JERre—— 'ﬂ Fopm Jtarct
& 2 ot inran v o e © o come e e g
» -:I = d
7l lay's iy oy il
| 8 = r

ighe cich & e in wres v mL Mk

™ [F hembhasy 15
-~ -
o . -
e

20 Comprehensive Disaster Management Programme (CDMP Il), DMRD, MoFDM



ArcGIS Basic

Removing a Spatial bookmark

1. Click the Bookmarks menu, and click
Manage.

2. Click a bookmark.

3. Click Remove.

Opening a Magnifier Window

1. Click the Window menu and click Magnifier.

You must be viewing the map in data view
to display a magnifier window.

2. When the magnifier window appears, drag
it over the data to see a magnified view.

3. Right-click the title bar and click Snapshot to
lock the view.

Opening an Overview Window

1. Click the Window menu and click Overview.

You must be viewing the map in data view to
display an overview window.

2. Drag, shrink, or expand the box in the
overview window to change the map
display in the active data frame.
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Exploring Data on a Map: Sometimes just looking at a map isn’t enough. You need to query data to
solve problems. ArcMap lets you explore the data on the map and get the information you need. You
can point at features to find out what they are, find features that have a particular characteristic or
attribute, examine all the attributes of a particular layer, and measure distances on the map. MapTips

also provide a quick way to browse map features. Like ToolTips for toolbar buttons, MapTips pop up as
you pause the mouse pointer over a feature.

Identifying features by pointing at them

1. Click the Identify button on the Tools

toolbar.
2. Click the mouse pointer over the map WG S W - ] I TT G T R T
feature you want to identify. ';___ = ,_’_,_: v s
The features in all visible layers under the = . f-.-/g
pointer will be identified. g i A
o et
T EE—
ra Lo o P A DY, e
.. - =) j :
Viewing a layer’s attribute table
1. In the table of contents, right click the layer I e e _H:_m
for which you want to display the attribute e —
table. “ & / -1;__,
; : 3 4
2. Click Open Attribute Table. Q== p },J-;::
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Finding features with particular attributes

1. Click the Find button on the Tools toolbar. e e P
2. Type the string you want to find in the Find —_— yra -
text box. = D s
3. Click the In layers dropdown arrow and click » < e
the layer you want to search. 2 gt
4. Uncheck Find features that are similar to or S
contain the search string if the string must s A
match exactly. el g = #‘"GE
5. Search for the string in all fields, in a specific . 'T&B
field, or in the primary display field. 9_['-' fmi———————— L
6. Click Find. ==y s | |

Measuring Distance

1. Click the Measure button on the Tools (3] @
toolbar. v

2. Use the mouse pointer to draw a line 08 8 co - Juaev passrsecsren
representing the distance you want to O ' A
measure. The line can have more than one "= v LSS
line segment. -k X UE

3. Double-click to end the line. k= e

Getting Help: A quick way to learn what ArcMap can do is to get help about the buttons and menu
commands you see on the interface. After clicking the What’s This? button, you can click an item in the
window to display a popup description of it. Sometimes a dialog box will also have a Help button on the
bottom; clicking it opens a Help topic with detailed information about the task you’re trying to
accomplish. Much of the information in this book is available in the ArcGIS Desktop Help system. The
Help topics are organized around the main tasks you want to complete as well as the concepts behind
the tasks. You can look up general Help topics in the Help Contents. You can search the Index for specific
tasks and issues. You can also use the Find tab to look up Help topics that have specific words or
phrases.

Tips for buttons and menus: When you pause the mouse pointer over a button, the button’s name

appears in a small box called a ToolTip. When you position the mouse pointer over a button or menu
command, a description of what it does appears in the status bar.
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Using the Help Contents to get Help

1. Click the Help menu and click ArcGIS T —
el &4 17

Desktop Help. O i | g

2. Click the Contents tab. e, | Pl —

3. Double-click a book to see a list of the
topics in that category.

a.

Double-clicking an open book closes its list.

4. Click the topic you want to read.

Searching the Index for help

1. Click the Help menu and click ArcGIS A E

: &
Desktop Help. 0—
e e by Paremap
2. Click the Index tab. 0——

3. Type the subject about which you want 0—_ _—

Loaking 81 & mao in dalas view and layoul view

...... Abreal v Basfrs B il v ol Lyl e

information. e
4. Double-click the topic you want to read. =

If several topics are related to your B
selection, the Topics Found dialog box
appears. Simply double-click the topic you - | | ——
want to read. o= | ¥

Finding Help topics containing specific word

1. Click the Help menu and click ArcGIS
Desktop Help.

2. Click the Search tab. .E = E"'l

3. Type the word that should be contained in 0— po——
the topics you want to find. =

4. Click List Topics.

5. Double-click the topic you want to read.
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Saving a Map and Exiting ArcMap: After you finish working on a map, you can save it and exit
ArcMap. You save a map as a document and store it on your hard disk. If you haven’t saved the map
before, you’ll need to name it, preferably with a name that adequately describes its contents. ArcMap
automatically appends a file extension (.mxd) to your map document name. The data displayed on a
map is not saved with it. Map layers reference the data sources in your GIS database. This helps to keep
map documents relatively small in size. So if you plan to distribute your map to others, they’ll need
access to both the map document and the data your map references. In general, it’s a good idea to save
your map periodically while editing it just in case something unexpected happens.

Saving a Map

1. Click the Save button on the Standard (1]
toolbar. - —

'J_Hd F. _f T Y £ e j»-l.l-'tl;lnu'!
If you haven’t saved the map ' o

. :nu‘nt-n.i H-'(Iu E‘lﬂop-rmlil‘\-o-r- § |
before, you’ll need to provide Pl =
a name for it. L

S [T i ] o — 1 f

e o RN L
Saving a map as new map
1. Click the File menu and click Save As. 0 . Qoo
2. Navigate to the location to save the map ‘:z’ i:':"s
document.
3. Type a filename. & asituga,
4. Click the Save as type dropdown arrow and T :
P i
click ArcMap Documents. A ::;
5. Click Save. & ore..
[ Me Prepertes. .
Jmeart
Epoth 2 e s
LW | ] Hen Mgl ot romd
2w :ﬂjy i Tdd
ST W Gickal q &se
R TurmsaHealhF scdin o

0w [RIHrs Cun
s oL

Fi pubssss [:J pearLlrar my
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Saving a map as a map template

1. Click the File menu and click Save As.

2. Navigate to the location to save the map
template.

3. Type a filename.

4. Click the Save as type dropdown arrow and
click ArcMap Template.

5. Click Save.

Exiting ArcMap

1. Click the File menu and click Exit. O o
2. Click Yes to save any changes, No to discard Qoo
any changes, or Cancel to continue working g
on your map. T 4
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Module Il

Displaying Data

The first step to creating a map is to locate the data
you want to put on it. Finding data may be as simple
as using ArcCatalog to browse your organization’s
GIS database or the spatial data distributed with
ArcMap.

In this Module, you’ll learn how to:

¢ Creating a new map

e Adding layers

¢ Adding shapefiles

e Adding data from the Internet

e Creating and adding a new feature class

* About coordinate systems

e Specifying a coordinate system

» Referencing data on a map
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Creating a New Map from Startup Dialog Box

1. Start ArcMap.

2. Click to create a new empty map, create a
map from a template, or browse for an
existing map.

3. Click OK.

Creating a New Empty Map

1. Click the New button on the Standard
toolbar to create a new empty map.

If you have a map open already, you'll be
prompted to save your changes.

Adding a Layer from ArcCatalog

1. Start ArcCatalog from the Start menu.

2. Arrange the ArcCatalog and ArcMap
windows so you can see both on the screen.

3. Navigate to the layer you want to add to the
map.

4. Click and drag the layer from ArcCatalog.

5. Drop the layer over the map display in
ArcMap.

The layer is copied to the map. Any
subsequent edits made to the layer on disk
will not be reflected on this map.
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Adding Layer from the Add Data Button

1. Click the Add Data button on the Standard
toolbar.

2. Click the Look in dropdown arrow and
navigate to the folder that contains the
layer.

3. Click the layer.

4. Click Add.

The new layer appears on your map.

e et e Dk
_:."-IB.

ar e
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Adding a Layer from another Map

1. Open the map that contains the layer you
want to copy.

2. In the table of contents, right click the layer
and click Save As Layer File.

3. Click the Look in dropdown arrow and
navigate to the folder where you want to
save the layer.

4. Type a name for the layer.

5. Click Save.

6. Click the Open button on the Standard
toolbar to open the map you want to add
the layer to.

7. Click the Add Data button.

8. Click the Look in dropdown arrow and
navigate to the folder that contains the
layer.

9. Click the layer.

10. Click Add

A dms g K- b2
¥

3 o alelo|F 8l
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Adding Data from ArcCatalog

1. Start ArcCatalog from the Start menu.

2. Arrange the ArcCatalog and ArcMap
windows so that you can see both on the
screen.

3. Navigate to the data source you want to add

to the map.
. Click and drag the data source from
ArcCatalog.

. Drop the data source over the map display
in ArcMap. ArcMap creates a new layer on
the map that references the data source.

Adding Data in ArcMap

1. Click the Add Data button on the Standard

toolbar.

2. Click the Look in dropdown arrow and
navigate to the folder that contains the data
source.

. Click the data source.

. Click Add.

w

ArcMap creates a new layer on the map that
references the data source.
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Displaying a Subset of the Features

1. In the table of contents, right click the layer
and click Properties.

2. Click the Definition Query tab.

3. Type an expression or click Query Builder.

The Query Builder lets you create an
expression to identify the particular features
in the layer you want to display. For
example, you might choose to display only
those cities with a population greater than
1,000,000.

4. Click OK.
o_...;.-.;.— |

o Camnsd I

Specifying a coordinate system: If all the data you want to display on your map is stored in the same
coordinate system, you can just add it to a map and not consider whether the layers will overlay properly; they
will. If, however, you’ve collected data from a variety of sources, you’ll need to know what coordinate system
each dataset uses to ensure ArcMap can display them together. When you add a layer to an empty data frame,
that layer sets the coordinate system for the data frame; you can change it later if necessary. As you add
subsequent layers, they are automatically transformed to the data frame’s coordinate system as long as there’s
enough information associated with the layer’s data source to determine its current coordinate system. If there
isn’t enough information, ArcMap will be unable to align the data and display it correctly. In this case, you’ll have
to supply the necessary coordinate system information yourself.

For coverages, shapefiles, and rasters, it’s stored on disk in a separate file named after the data source but with a
.prj file extension (for example, streets.prj). These files are optional files; thus you may still need to define the
coordinate system for one of these data sources. You can create a .prj file with ArcCatalog. If no coordinate
system information is associated with a data source, ArcMap will examine the coordinate values to see if they fall
within the range: -180 to 180 for x-values and -90 to 90 for y-values. If they do, ArcMap assumes that these are
geographic coordinates of latitude and longitude. If the values are not in this range, ArcMap simply treats the
values as planar x,y coordinates.
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Displaying data with a predefined coordinate system

1. Right-click the data frame that you want to T —————

set the coordinate system of and click T T

[T

Properties. a i
2. Click the Coordinate System tab. les
3. Double-click Predefined. e
4. Navigate through the folders until you find :

the coordinate system you want and click it.
5. Click OK. (s

=

All layers in the data frame will now be T '
displayed with that coordinate system. Qo= |
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Modifying the parameters of a coordinate system

. Right-click the data frame whose coordinate i
system you want to modify and click b
Properties. !

. Click the Coordinate System tab. T e 4

. Click Modify. v

4. Adjust the coordinate system properties as e
appropriate. i il

5. Click OK. =

6. Click OK on the Data Frame Properties St
dialog box. [ 1 I —

ArcGIS Basic
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Setting the units for reporting lengths and displaying coordinates

1. Right-click the data frame and click I ———
Properties. e LT i e

2. Click the General tab. <4 Laivan

3. Click the Map dropdown arrow and click the
appropriate units.

The map units option is only available when AR
your data has no coordinate system )
information associated with it. - _':"'“"'“-'

4. Click the Display dropdown arrow and click fomee
the appropriate units. p—=r |

5. Click OK
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Referencinq data on a map: When you add a layer to your map, ArcMap references the data source the
layer is based on. When you save the map, the data references are stored with it. The next time you open your
map, ArcMap locates the data based on the references. If ArcMap can’t find a data source, you’ll need to either
locate the data source yourself or ignore the reference, in which case the layer won’t be drawn. If you plan on
distributing your maps to others, they’ll need access to the data referenced on it. If they have access to the data—
for example, data stored on a server—they can simply update the references to the data if necessary. If they don’t
have access to the data, you’ll probably have to distribute the data with your map. To help make it easier to
distribute data with your map, ArcMap allows you to store relative pathnames to data sources referenced on a
map. This lets you, for example, distribute your map and data in the same directory. The references stored in the
map are correct regardless of where they are placed on disk.

Repairing and updating data links: When you first open a map, ArcMap searches for the data
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referenced by the layers on the map. If it can’t find the data— for example, because the data has been
moved—the layer won’t display. You can immediately tell which layers on your map have broken links
because you’ll see a red exclamation mark next to their names in the table of contents. If you know the
new location of the data, you can repair the link. You can also update the link to a layer’s data source.
You might want to do this when, for example, you want to retain the layer’s display properties but use
an updated attribute table.

Storing relative pathnames to data

1. Click the File menu and click Document

B e e i

Properties. '3; owm | & Siseow
2. Click Data Source Options. L - '
3. Click Store relative path names. :f::'.-._
P g
H . . :im
5. (ljollck OK on the Document Properties dialog bl
OX. o—'ﬁ'_“__w

By [ ek T EIEEEEE I Tl

A

[ [
e =
fthsn |
Lempy |
(RS |

|
ek baee |
Tesjurs O P ]
R 1Y,

™ Grusd |
Fa [he spstem palh names to dats souces _o
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Repairing broken data source links

. Locate the layer with the broken link in the Tt
Dada BT n 'Il—:.l..ﬁ_l‘ﬂ“

table of contents. It will have a red A e LI LT
exclamation mark next to it. 1 @
2. Right-click the layer, point to Data, and click
Repair Data Source.
. Click the Look in dropdown arrow and
navigate to the location of the data source.
4. Click the data source.
5. Click the Add button. The link to the data
source is now updated.

3l & olsele | [= mis|
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Updating a link to a data source

. In the table of contents, rightclick the layer ol S

and click Properties. e T—
[P e | Wl

. Click the Source tab. = i)

. Click Set Data Source. '8

. Click the Look in dropdown arrow and .;u_-'-“
navigate to the data source. e

. Click the data source. e

. Click Add. =

e o | | Dot | Dt | Pt | ot s | e | i S|
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Module IV

Working with Layers

You can think of a layer as a specific way to display
and work with geographic data. Layers exist within
maps and can be saved independently of maps in a
database or as a layer file (.lyr). In fact, many
organizations save layers for their staff to access
rather than providing direct access to the
organization’s geographic data. This helps to ensure
that those accessing the data are viewing the same
information.

In this Module, you’ll learn how to:

e Adding layers

® Changing a layer’s text

e About the drawing order

e Copying layers

* Removing layers from the map

® Grouping layers

e Saving a layer to disk

» Accessing layer properties

e Displaying a layer at specific scales

¢ Creating a transparent layer

e Changing the appearance of the table of contents
¢ Using data frames to organize layers
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Adding a layer file in ArcMap

1. Click the File menu and click Add Data, or
click the Add Data button on the Standard
toolbar.

2. Click the Look in dropdown arrow and
navigate to the folder containing your layer
file.

T T R R e I Yol

3. Click the layer file. ] w| sl [F Bl
4. Click Add.
ArcMap adds the layer to your table of |
contents using the special properties it was
saved with.
S 10
Showal g [Cwaiet: arcLavers bl =l Carcel |

Changing the name of a layer

1. In the table of contents, click the layer to
select it.

2. Click again over the name. This will highlight
the name and allow you to change it.

3. Type the new name and press Enter.

NOTE: This does not change the actual
filename.

ElE A - S LS L O
CrTr T

Changing the map feature label

1. In the table of contents, click the text you
want to change.

2. Click again over the text string.
This will highlight the string and allow you to
change it.

3. Type the new description and press Enter

s A S s
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Moving a layer to change its drawing order
1. In the table of contents, click and drag the
layer up or down.

A black bar indicates where the layer will be
placed. This bar indents to reflect the
position in the layer hierarchy where the
drop will occur.

2. Release the mouse pointer to drop the layer

in its new position. — i Ly
e & ONATCETe= 00 A" A win A S g

L L

Copying a layer between data frames

1. Right-click the layer or layers you want to ':;':— T ———
copy to another data frame and click Copy. I e c—— >
2. Right-click the data frame you want to copy o o ',',:m" -
the layer or layers into and click Paste | & : ,_
Layer(s). S ' -
You can also drag and drop a layer from one e s W
data frame to another. R |
If you want to move your layer instead of L, L = : _
copying it while you drag and drop, hold =T e = A neategsT =
down the Ctrl key when you drop the layer. e e
P

Copying a layer to another map

1. Right-click the layer or layers you want to
copy to another data frame and click Copy.

2. Click the Open button on the Standard
toolbar and open the map you want to copy

the layer or layers into.
3. Right-click the data frame you want to copy 0—
the layer into and click Paste Layer(s).
T ikl L O
o RDem e
If you don’t want to close your original map, Co s
. - Eperd M Ly
open another ArcMap session s
e L ¥ J
= Advance (g ohorn g
el D Ly " ’ o
I‘JE = +---J &
: S Cimoms| Frhams s gt e f'-:\.ﬁ::
B i
[ Prowim
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Removing a layer

1. In the table of contents, right click the layer B e e
or layers you want to remove. L O T T

2. Click Remove.

> .i-l.!',.. )
o ;:—u}- )
S -+ I
Py ’
i“'_\. :::_ asn &-‘- ol =
Removing Several Layers
1. In the table of contents, click the first layer e e
you want to remove. sanszrees -J-._u'..- T
2. Hold down the Shift or Ctrl key and click to -
select additional layers. e
3. Right-click the selection and click Remove. - ]
I :
M 3,
e P =)
Ia--n--'lrn M"‘.“'V'.':"P ) “Hl A mr o A ik_- g'_-._r- T ‘;J
Creating a Group Layer
1. Right-click the data frame in which you want e ——— =]

to create a group layer.
2. Click New Group Layer.

A new group layer appears in the table of
contents.

Grouping Layers: When you want to work with several layers as one layer, you gather them together
into a group layer. For example, suppose you have two layers on a map representing railroads and
highways. You might choose to group these layers together and name the resulting layer
“transportation networks”. A group layer appears and acts like an individual layer in the table of
contents. Turning off a group layer turns off all its component layers. The properties of the group layer
override any conflicting properties of its constituent layers.

41 Comprehensive Disaster Management Programme (CDMP Il), DMRD, MoFDM



ArcGIS Basic

Grouping layers in the table of contents

1. Hold the Ctrl key and highlight multiple T
NEaa " [ CI Y Ya
layers in the table of contents. CEEEL LAY TTy
2. Right-click one of the chosen layers. Tt

3. Click Group.

A new group layer appears in the table of
contents containing the selected layers.

. off
Adding layers to a group layer
1. Double-click the group layer in the table of
contents to display its properties.
2. Click the Group tab.
3. Click Add.
4. Click the Look in dropdown arrow and
navigate to the data source you want to add
to the group. T ——
5. Click the data source. “’I"F' 2 & ol siz)
6. Click Add. 0=
Tip: If the layer you want to add to a group
is already on the map, you can drag and
drop it in the group.
P sroup - o j—-@
L [ S [Py p——"" :J [ I
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Removing a layer from group layer

1. Double-click the group layer in the table of 2
contents to display its properties.
2. Click the Group tab. "m" i
3. Click the layer that you want to remove. e Luers
4. Click Remove. o
5. Click OK.

T _ome | |
@

Saving a Layer to Disk: One of the main features of a layer is that it can exist as a file in your GIS
database. This makes it easy for others to access the layers you’ve built. When you save a layer to disk,
you save everything about the layer. When you add the layer to another map, it will draw exactly as it
was saved. This is very convenient when others at your organization need to make maps but don’t know
how to represent or access the data in your database. All they need to do is add the layer

Passing layers to others: Don’t forget, the layer file is just a link to the actual data source. So if you
are passing the layer to others, be sure they also have the data referred to in the layer.

Saving a layer to disk

1. In the table of contents, right click the layer
and click Save As Layer File.

L ._" B g
2. Click the Look in dropdown arrow and = | kX
navigate to the location where you want to == gz-'\
save the layer. T . X ;
3. Optionally, change the layer name. j“
4. Click Save === leoemaat
2]
e =S
S _~+~—0
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Displaying layer properties

1. In the table of contents, right click the layer ST
and click Properties. ma—

2. Click the tab containing the properties you — S \tx\
want to adjust. i el L\
3. When finished, click OK. s t’ A
S = |
o_"‘__ | P
(2]

b [ o - 0 e

e [

Displaying a layer at specific scales: To help you automatically display layers at the appropriate
scale, you can set a layer’s visible scale range to define the range of scales at which ArcMap draws the
layer. Whenever the scale of the data frame is outside the layer’s visible scale range, the layer won’t
draw. In this way, you can control how the map looks at various scales. For example, you can hide a
detailed layer that might otherwise clutter your map when you zoom out. You can also progressively
display more detailed layers as you zoom in on an area, that is, as the scale of the data frame gets
larger. Setting a visible scale range is especially useful if you are creating a map for others to use
because it makes browsing the map easier.
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Setting the minimum visible scale for a layer

1. Right-click the layer in the table of contents
and click Properties.

2. Click the General tab. B |Sscs | S| Dag | Spobo] ks | Bt oy | o | i L s |
3. Click Don’t show layer when zoomed. P P e
4. Type a minimum scale for the layer. s | j
If you zoom out beyond this scale, the layer i e
will not be visible. T:;“::'::m'm"““m
5. Click OK. O— e
P 8 50 ‘I"ll' ﬁ
P o
I N
(5
Setting the maximum visible scale for a layer
1. Right-click the layer in the table of contents
and click Properties.
2. Click the General tab.
3. Click Don’t show layer when zoomed.
4. Type a maximum scale for the layer. sl | ecn | S | D | G| Pt | iton umy | Lot | s i
If you zoom in beyond this scale, the layer N e F et
will not be visible. e | j
5. Click OK. Somfr
Yo L giely B targe of oo o ehch e L vl b dhoma
T e g o ol sl
¥ D) s e o rarvent. ST
o "4
e = | / 'k
Lo ] oo |_aw ||

0
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Setting a visible scale based on the current scale

1. Adjust the data frame display to the
appropriate scale.

2. Right-click the layer for which you want to
set a visible scale.

3. Point to Visible Scale Range and click Set
Maximum Scale or Set Minimum Scale.

ij-_-—:— j|  HemlalamFe 1.Jfﬁ"'+‘;'_l =y
Aty
Clearing a layer’s visible scale
1. Right-click the layer for which you want to T e
clear a visible scale range. TP TITY TV A—
2. Point to Visible Scale Range and click Clear [T ll [ by ;‘“‘“-i:i?uﬁ_H! = -
Scale Range. o : T
E. . j;::‘imlﬂ
ki ¥ o .
P i
] ] lewdilegeia B B RN S e L
£ Fropete

Creating a_transparent layer: Giving a layer transparency is an easy way to show varying and
overlapping information. One situation in which transparency might be useful is if you needed to see
the information displayed in two overlapping polygon layers. Similarly, another use is to allow you to
see an image under a polygon layer.

Changing a layer’s source data: The properties saved within a layer file can be applied to other
data sources at times. This data needs to be in the same format with the same attribute information.
You might do this when using updated census data, for example. This data will be in the same format;
therefore, the data should display using the same layer properties as the previous data. You might also
change source data to allow for a consistent presentation between counties using data with the same
table and feature classes.
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Setting the layer’s transparency

1. Right-click the layer and click Properties.
. Click the Display tab.
3. Enter the transparency value, in percent, you

wish this layer to be displayed with.
4. Click OK.

N

If you are uncertain how transparent you
want the layer, click Apply before OK, and
keep changing the transparency value
before you close the Properties dialog box.

Showing the Display, Source, and Selection tabs

1. Click the Tools menu on the Standard toolbar
and click Options.

2. Click the Table Of Contents tab.

3. Check the boxes to show the Display, Source,
and Selection tabs.

4. Click OK.
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Viewing the data source in the table of contents

1. Click the Source tab in the table of contents. 8 e e i 5 e . —
e s N =N

Changing the appearance of the table of contents: You can adjust the look of the table of
contents to suit your needs. For example, you might change the text size and font so it makes a greater
visual impact or is easier to read. You also might want to change the shape of the lines and patches that
represent the features on a map. The table of contents has three tabs at the bottom, a Display tab,
Source tab, and a Selection tab. The Display tab shows the drawing order of the layers and allows you
to change the order. The Source tab sorts layers by where they’re stored on disk. The Selection tab
shows a list of the layers in the active data frame and lets you check the ones you want to make
selectable. Seeing the Source tab is useful during editing, when you edit all layers in a given folder or
database. If you’re not planning on using your map for editing, you can hide the Source tab. You can’t

change the drawing order of layers from the Source tab.

Setting the text font for layers

1. Click the Tools menu on the Standard toolbar
and click Options.

2. Click the Table Of Contents tab.

3. Uncheck Use Windows Desktop Settings.

4. Click the Font dropdown arrow and click the ot S [
font you want to use. o -
5. Click the Size dropdown arrow and click the I - &
font size. i i
6. Click OK. 00— *_-'-;,-__:EE-_::_-_:T'_.: o
o) - o
- 3
thei 2 - —j
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Setting the line and patch for layer symbology

awm Iy W

1. Click the Tools menu on the Standard toolbar T
and click Options. | [
2. Click the Table Of Contents tab. e E o
3. Click the Line or Area dropdown arrow and | e [12 ) e
click the appropriate shape.
4. Click OK.

Adding a data frame

1. Click the Insert menu.
2. Click Data Frame.

The new data frame will
appear in the table of
contents and in the center of
the layout when in layout
view 2 ]

Making a data frame active

1. Right-click the data frame in the table of 5 08 o e e

ST Lt Ay 11T =

ContentS. %ﬂ?[:.’"‘-:m. T
Bl i - 7
2. Click Activate. 1 L —

Pt ] el

You can also click the frame in layout view to
activate it.

e — AT Jins Rl AT s gy
S Corvees Lwarms o i —_—

Eciats

' Froparin
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Removing a data frame

0 e o S e

1. Right-click the data frame in the table of
CARE . B s 4T T A
contents that you want to remove. LEREA LA T

2. Click Remove. o_.h;w%__“ {i
0

In layout view, you can select
the data frame and press the Lot
Delete key on the keyboard. R =

= —

- N
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Module V

Symbolizing Features

Choosing how to represent your data on a map may

be the most important mapmaking decision. How

you represent your data determines what your map

communicates. On some maps, you might simply

want to show where things are. The easiest way to

do this is to draw all the features in a layer with the

same symbol. On other maps, you might draw

features based on an attribute value or

characteristic that identifies them. For example, you

could map roads by type to get a better sense of

traffic patterns.

In general, you can draw map features:

e With a single symbol

* To show a category such as a type (unique values)

* To represent a quantity such as population
(graduated color or symbol, and dot density maps)

e To show multiple attributes

In this Module, you’ll learn how to:

¢ Drawing all features with one symbol

e Drawing features to show categories

e Managing categories

¢ Ways to map quantitative data

e Standard classification schemes

e Setting a classification

* Representing quantity with color, graduated or
proportional symbols, and charts

e Drawing features to show multiple attributes

e Working with advanced symbolization
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Drawing a layer using a single symbol

. In the table of contents, right click the layer
you want to draw with a single symbol and
click Properties.

. Click the Symbology tab.

. Click Features.

Because Single symbol is the only option,
ArcMap automatically selects it.

. Click the Symbol button to change the
symbol.

. In the Symbol Selector dialog box, click a new
symbol or change specific properties of the
symbol.

. Click OK on the Symbol Selector dialog box.

. Type a label for the feature. The label
appears next to the symbol in the table of
contents.

. Click OK

?

ArcGIS Basic
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Click Description if you want an additional
description of your layer to appear in your legend.
You can press the Ctrl and Enter keys together in
the Description for Legend dialog box to inserl a
line break in your description. For mare information
on working with legends, see Chapter 15, ‘Laying
out and printing maps’.
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Drawing a layer showing unique values

1. In the table of contents, right click the layer
you want to draw showing unique values and
click Properties.

Gormal | Souce | Selecton | Daplee  Spmbioiogy | Fids | oy | Labsst | Jours & Rt |

2. Click the Symbology tab. Q—Ff;-:- Bram e ey
3. Click Categories. Lman .
ArcMap automatically selects the Unique Qe .
values option. =
L]

4. Click the Value Field dropdown arrow and
click the field that contains the values you
want to map.

5. Click the Color Scheme dropdown arrow and
click a color scheme.

6. Click Add All Values. 6/ 00
This adds all unique values to the list. Double-click a symbol
Alternatively, click the Add Values button to b

choose which unique values to display.

7. If you want to edit the default label so more
descriptive labels appear in your legend and
the table of contents, click a label in the
Label column and type the label you want.

8. Click OK.

Reversing the sort of unique values

1. In the table of contents, rightclick the layer
whose unique values you want to sort and

click Properties. Gawn] S| Seucon | st Sty | ke | Dt Dy | Labeh | S s |

2. Click the Symbology tab. i Diam catgares uning unfin viborsof on b |

3. Click the Value column to show a context k| Ii;_lh;_ Eim
menu. (™ [ o [=

4. Click Reverse Sorting to reverse the mﬂ-
alphanumeric sorting of the entire list of o oyt 0
classes. b .

5. Click OK. Pt T

Ligri Inchusiny j

e | | e
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Ordering unique values

1. In the table of contents, rightclick the layer
whose unique values you want to reorder

and click Properties. | S| S| Dk 5| e | O i |
2. Click the Symbology tab. frower P Vb Wk Sl |
3. Click the value you want to move up or down el | L 3 [v - -
in the list. Rt
4. Use the up and down arrows to either e At
promote or demote the value in the list.
5. Click OK.

" e ——— 0
i Tyt sy 1]
R | [Ty

Combining two or more categories into one

1. In the table of contents, rightclick the layer
drawn with unique values you want to

combine categories for and click Properties. e e e Sy e

e Dusm sty s s ol e lekd _imper_ | I
2. Click the Symbology tab. — oot e —
If you don’t already see categories in the M b [ s T
scrolling list, follow the steps for ‘Drawing a fhate - e e N
layer showing unique values’ earlier in this

chapter.

3. Click the first of the values you want to
combine. Hold down the Shift or Ctrl key and
click the additional values that you want to
combine.

4. Right-click over the values and click Group
Values. The selected values will now be
combined into one category.

5. If you want more descriptive labels to appear
in your legend and the table of contents,
click a label in the Label column and type the
label you want.

6. Click OK.

54 Comprehensive Disaster Management Programme (CDMP Il), DMRD, MoFDM



ArcGIS Basic

Ungrouping combined categories

1. Right-click a combined category in the
scrolling list.

2. Click Ungroup Values.
The symbols for each of the ungrouped
values are the same as when they were
grouped

Setting a standard classification method

1. In the table of contents, rightclick the layer
that shows a quantitative value for which you
want to change the classification.

2. Click the Symbology tab.

3. Click Quantities.

4. Click the Value dropdown arrow and click the
field that contains the quantitative value you
want to map.

5. To normalize the data, click the
Normalization dropdown arrow and click a
field.

ArcMap divides this field into the Value to
create a ratio.

6. Click Classify.

7. Click the Method dropdown arrow and click
the classification method you want.

8. Click the Classes dropdown arrow and click

the number of classes you want to display.

9. Click OK on the Classification dialog box.

10. Click OK on the Layer Properties dialog box.
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Inserting your own class breaks and setting a range

1. In the table of contents, rightclick the layer
for which you want to set class breaks and
click Properties.

2. Click the Symbology tab.

If you have not already set a classification
method, follow the steps in ‘Setting a
standard classification method’ earlier in this
chapter.

3. Click the Range you want to edit.

Make sure to click the Range, not the Label.

4. Type a new value. This sets the upper value

of the range.

5. Click OK

Deleting a class break

1. Click Classify from the Symbology tab of the
Layer Properties dialog box.

2. Click the class break you want to delete.
The selected break is highlighted.

3. Right-click over the histogram and click
Delete Break.
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Excluding features from the classification

1. Click Classify from the Symbology tab of the
Layer Properties dialog box. o —

. . et [ies = ard T
2. Click Exclusion. — — |—‘ = o
3. Double-click the field you’re using to draw s 2 el -
the layer. r s | i
P[5 2] T G [ Sy (|

4. Click an operator.

5. Click Get Unique Values and double-click the
value you want to exclude.

6. Click OK to execute the expression and i
exclude values. }
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Symbolizing data with graduated colors

1. In the table of contents, rightclick the layer HO® O 6
you want to draw showing a quantitative value
and click Properties.

2. Click the Symbology tab.

3. Click Quantities.

ArcMap automatically selects

Graduated colors.

4. Click the Value dropdown arrow and click the
field that contains the quantitative value you
want to map.

5. To normalize the data, click the
Normalization dropdown arrow and click a

field g ot ] b |
ArcMap divides this field into the Value to Right-click a class to (11]
create a ratio see additional options,
. i such as sorting and
6. Click CIaSSIfy' number formatting.

7. Click the Method dropdown arrow and click
the classification method you want.

8. Click the Classes dropdown arrow and click
the number of classes you want to display.

9. Click OK on the Classification dialog box.

10. Click the Color Ramp dropdown arrow and
click a ramp to display the data with.

11. Click OK on the Layer Properties dialog box. TR B [
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Creating your own color ramp for a layer

1. In the table of contents, rightclick the layer
that shows a quantitative value and click
Properties.

2. Click the Symbology tab.

3. Click Quantities.

4. Double-click the top symbol in the list and
set the start color for the ramp.

5. Double-click the bottom symbol and set the
end color.

6. Optionally, double-click any middle symbol
to set its color. This lets you create a
multipart color ramp.

7. Click all the middle symbols you’ve set the
color of.

By selecting one or more middle symbols,
the color of those symbols is included in the
new ramp. Otherwise, ArcMap only uses the
top and bottom symbols.

8. Right-click a symbol and click Ramp Colors.

9. Optionally, if you want to use the new color
ramp on another layer, right-click the Color
Ramp dropdown and click Save to style to
save your new ramp to your default style.

10. Click OK.
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Representing quantity with graduated symbols

1. In the table of contents, rightclick the layer
you want to draw showing a quantitative
value and click Properties.

2. Click the Symbology tab.

3. Click Quantities and click Graduated symbols.

4. Click the Value dropdown arrow and click the
field that contains the quantitative value you
want to map.

5. To normalize the data, click the
Normalization dropdown arrow and click a
field. ArcMap divides this field into the Value
to create a ratio.

6. Type the minimum and maximum symbol
sizes.

7. Click Classify.

8. Click the Method dropdown arrow and click

the classification method you want.

9. Click the Classes dropdown arrow and click
the number of classes you want.

10. Optionally, click Exclusion to remove
unwanted values from the classification (for
example, null values or extreme outliers).

11. Click OK on the Classification dialog box.

12. Click OK on the Layer Properties dialog box.
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Representing quantity with proportional symbols

1. In the table of contents, rightclick the layer
you want to draw showing a quantitative

value and click Properties. i bl T e |
2. Click the Symbology tab. G T rmamr ||
3. Click Quantities and click Proportional 0____ i £
symbols. e e S
4. Click the Value dropdown arrow and click the | ""6
field that contains the quantitative value you
want to map.
5. To normalize the data, click the
Normalization dropdown arrow and click a

field. ) [7)

ArcMap divides this field into the Value to
create a ratio.

L] ] £ L l .
) ] . s Ml*=r= | How tho proportional
6. Optionally, click Background and Min Value 2 eel® symibols appear on your map
to change the symbol properties and NECE SR x " s ki
. = . . el 9o i- ,re."_uw with a black outling
background of the proportional symbols. e Lig ] -8 ] and the Min Value symbol is
7. Click OK .| .-' Blel, = . Y blue with a black oullina
. Clic . T [sre -
® 1

. 1000 Proporlional symbols appear in
the tegend and table of contenis
as a stack of progressively

farger biug circles,
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Representing quantity with proportional symbol as values are measurement on a map

1. In the table of contents, rightclick the layer
you want to draw showing a quantitative
value and click Properties.

2. Click the Symbology tab.

3. Click Quantities and click Proportional
symbols.

4. Click the Value dropdown arrow and click the
field that contains the quantitative value you
want to map.

5. To normalize the data, click the
Normalization dropdown arrow and click a
field. ArcMap divides this field into the Value
to create a ratio.

G| Lo | Tt | Dot bt | funf | S S| e | o b |

frmed| S| o | Gy et | P | Dt o | Lo | s e |
6. Click the Unit dropdown arrow and click a :_ Tt A et~ ]
unit. _—a Al ] i
7. Click Square or Circle as the symbol. :-" “ T N peen

Optionally, change the color of the symbol
and click Background to change the
background of the proportional symbols.

8. Click Radius or Area. For example, click
Radius if your data represents the distance o e B
an earthquake was felt from its epicenter. © 00
Click Area if the value represents an area.

9. Click OK.

Drawing a dot density map

1. In the table of contents, rightclick the layer (6]
you want to draw showing a quantitative
value using dot densities and click Properties. i o Sl
2. Click the Symbology tab. 3 ’-‘—"-—-—" _-""T" 3 | = :
3. Click Quantities and click Dot density. 0 = | =i ;j
4. Click the field or fields under Field Selection l'“'" — s it — — _
that contain the quantitative values that you 3 Tesry b E.
want to map. "' M e p—’—’ fl
5. Click the arrow button to add fields to the - e
field list. Bl ssowan] s
7] O ©0
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6. Double-click a dot symbol in the field list to
. . Tt | Jousts | Swimcter| Dapiy  Swminiogy | Fus | Dot | Lt | Jors & Fosiems |
change its properties. f S R L AT ot
7. Type the dot size or click the slider to adjust b : S [ I
the size. : ' L
. . ||
8. Type the dot value or click the slider to =
adjust the value. [ BN _§ ol
9. Check Maintain Density to preserve the dot i
: ytop i ettt D
density. P
When checked, as you zoom in, the dot size
will increase so a given area will visually ! | _twee | s |
appear as dense. Otherwise, the dot size will o
remain constant.
10. Optionally, click Properties to set the dot
placement options and use Masking. i SR
. [ % How the dol densily map appears
11. Click OK ThaR when the dols are black and the

Background has a gray county
boundany outiine and a sand

background
Dot density appears in the
1Dot=1000 legend and table of contents as
BOPS0S a sgquare paich wilh randormiy

placed dots.

Drawing pie charts

w

. In the table of contents, rightclick the layer
you want to draw showing quantitative
values with charts and click Properties.

. Click the Symbology tab.

. Click Charts and click Pie.

. Click the fields under Field Selection that 0
contain the quantitative values that you € e —
want to map.
Choosing more than one field shows the o
relationship to the whole. E § e, ——

. Click the arrow button to add fields to the 3
field list.

. Click the Color Scheme dropdown arrow and
click the colors you want to use or double- R0 (6 ]

-3
& Tahar
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click a symbol in the list to change its
properties.

7. Check the box to prevent the charts from
overlapping.

8. Click Size.

9. Click the Variation Type you want. You can
either draw all pies the same size or vary the
size based on the sum of the attributes or a
particular attribute value.

10. Type a size or click the arrows to set the

size.

11. Click OK.

12. Click OK.

Drawing bar or column charts

1. In the table of contents, rightclick the layer
you want to draw showing quantitative
values with bar or column charts and click
Properties.

2. Click the Symbology tab.

. Click Charts and click Bar/ Column.

4. Click one or more fields under Field Selection
that contain the quantitative values that you
want to map.

5. Click the arrow button to add fields to the
field list.

6. Click the Color Scheme dropdown arrow and
click the colors you want to use.

You can double-click an individual symbol in
the list to change its properties.

7. Check the box to prevent the charts from
overlapping.

8. Click Size.

9. Type a maximum length or click the arrows

to set the length.

10. Click OK.

11. Click OK.
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Drawing stacked charts

w

. In the table of contents, rightclick the layer

you want to draw showing quantitative
values with stacked charts and click
Properties.

. Click the Symbology tab.
. Click Charts and click Stacked.
. Click the fields under Field Selection that

contain the quantitative values that you
want to map.

Choosing more than one field shows the
relationship to the whole.

. Click the arrow button to add fields to the

field list.

. Click the Color Scheme dropdown arrow and

click the colors you want to use. You can
double-click an individual symbol in the list
to change its properties.

. Check the box to prevent the charts from

overlapping.

8. Click Size.
9. Type a maximum length or click the arrows

to set the length.

10. Click OK.
11. Click OK.
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Drawing a layer to show both categories and quantities

1. In the table of contents, rightclick the layer
you want to draw showing multiple
attributes and click Properties.

2. Click the Symbology tab.

3. Click Multiple Attributes.

ArcMap automatically selects Quantity by
category.

4. Click the first Value Fields dropdown arrow
and click the field that contains the values
you want to map.

5. Click the Color Scheme dropdown arrow and

click a color scheme. Co ] om | o]
6. Click Add All Values. .
7. Click Symbol Size or Color Ramp, depending © ® 0
on how you want to symbolize the 0
guantitative value. This example shows
Symbol Size. e Slotin
8. Click the Value dropdown arrow and click the :..,,,,—:3] n...“%‘;;

guantitative value you want to map.
Set other options as described in the
‘Representing quantity’ sections of this
chapter.

9. Click OK.

T Shuss chain bopahor ) fshrn soboms

10. Click OK o] o
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Module VI

Working with Labels

Labeling is the process of placing descriptive text
onto or next to features on your map. In ArcGlS,
labeling refers specifically to the process of
automatically generating and placing descriptive
text for map features. A label is a piece of text on
the map that is derived from one or more feature
attributes. Labels are not selectable, and you cannot
edit the display properties of individual labels.
Labeling is useful to add descriptive text to your map
for many features. Labeling can be a fast way to add
text to your map, and it avoids you having to add
text for each feature manually. In addition, ArcMap
labeling dynamically generates and places text for
you. This can be useful if your data is expected to
change or you are creating maps at different scales.

Annotation is an alternative to labeling. If you only
want to add descriptive text for a few features, if
you want to reuse your text and make it appear in
the same place all the time, or if you do not have
attributed features, it will be better to add your text
as annotation. Labeling your features is a good way
to create annotation.

In this Module, you’ll learn how to:

¢ Use label manager

e Labeling based on attribute table

e Building label classes from symbology classes

e Build label expression

e Examples of label expression
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The Labeling toolbar and the Label Manager

The Labeling toolbar is where you start labeling in ArcMap. From here you can control the labeling
process and open the Label Manager, which lets you view and change labeling properties for all the
labels in your map.

Open the Label Manager. Change label and feature weaights

Lisis the map's

Sel labeling options.

Change prionty

Lt~

aaE R

Show unplaced labels

Lock the current size and
location of labeals

ordaer of labals

layers and label Ll Claines
classes. ——=Fe B sowoh G Spq:*,::h,u a single Neld or
B Dietnt . | expression used to
B Hedh st (. T 3 M gonerate label slrings
Click a layer 1o _._._hgj S T '
vl ﬂw L — n S
manaoe ils label B Deind o | - Change label appearance
classos B Hafoeay ared momw onid - -—J ---1
o b Fipatends itom s il i Sal a ional |abe
‘jm_”::— [ ] I .|,i!| ot | | Sal additional label
3 O] moerl_wwss appearance properies
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: 1 5@ label slyles.
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o | ceed | s |

Set a visible scale range for labels

Use a SOL expression 1o label cenal

in features

Adding the Labeling toolbar and opening the Label Manager

1. Click the View menu, point to Toolbars, and

click Labeling.

2. Click the Label Manager button

s
s = O

W
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Labeieg ™ sliii'&ié:ﬁ

0
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Using the Label Manager

1. Open the Label Manager by clicking the Label

2. Check the box next to the layer you want to

w

4. Click the Label Field dropdown arrow and

Manager button on the Labeling toolbar.

label.
. Choose a label class under the layer.

click the attribute field you want to use as a

label.
5. Click OK.
s +| Jownit | et | uh""] WG | Lty |
I T
Changing label symbols
1. Open the Label Manager. ki
2. Click a label class in the Label Classes list. ;E B
3. Click the buttons and dropdown menus in B ot s
. g e AF = _e
the Text Symbol box to set the font, size, e e elela] :I_
color, or other symbol properties of your i e 4
labels. ew—--:n- BN CA e
4. Optionally, click the Symbol button to R T T v ————
chf':m.ge other properties or to choose an e e | e | sim | e |
existing text symbol for your labels. T tasto] o
5. Click OK

(5
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Building label classes from symbology classes

1. Open the Label Manager.
2. Click a layer in the Label Classes list.
3. In the Select symbology categories box,

check the box next to the symbology class
you want to use to make a new label class.

4. Click the Add button.
5. Click Yes or No on the Overwrite label classes

dialog box, depending on what you want to
do with your existing label classes.

6. Click OK

Using label styles

1.
2.
3.
4,

Open the Label Manager.

Click a label class in the Label Classes list.
Click the Symbol button.

Click a standard label style from the left pane
of the Symbol Selector dialog box.

. Optionally, modify the properties of a label

style and click Save to save your new symbol
in your personal style folder.

. Click OK on the Symbol Selector dialog box.
. Click OK on the Label Manager dialog box
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1. Open the Label Manager.

2. Click the layer in the Label Classes box for
which you want to create label classes.

3. Type a name for your new label class in the
Enter label name box.

4. Click Add.

5. Uncheck the Default label class to avoid
labeling some features twice.

6. Right-click the new label class in the Label
Classes list and click SQL Query.

7. Click the operators to build an expression
that identifies the subset of features you
want to label.

8. Click OK.

9. Click the Label Field dropdown arrow and
click the attribute field you want to use as a
label.

10. Click the buttons and dropdown menus to
define the symbol and placement properties
of your labels.

11. Repeat steps 2 through 10 if you want to
create additional label classes.

12. Click OK

| In this example, cities with a
population greater than
1,000,000 will be labeled
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Labeling based on a single attribute field

1.
2.
3.

4,

Open the Label Manager.

Click a label class in the Label Classes list.
Click the Label Field dropdown arrow and
click the field you want to use as a label.

Click OK.

Labeling based on multiple attribute fields

A WN -

. Open the Label Manager.

. Click a label class in Label Classes list.

. Click Expression.

. Click a label field and click Append to use the
text of that field in your labels.

. Optionally, use the Expression box to add
additional characters you want to appear in
your labels or add VBScript or JScript
functions to format your labels.

. Click Verify to make sure that there are no
syntax errors and to preview your label
string. Close the Label Expression
Verification dialog box.

. Click OK.

. Click OK.
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To create stacked text, use the VBScript constant, vbNewLine,
hetween the field names—[PARCEL _|D] & vbNewlLine &
[LAND_USE]. You can also click the Help button for more
information on syntax and building label exprassions.
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Building label expressions

About label expressions: You can use label expressions to adjust the formatting of your labels. In
addition to inserting characters and scripting functions, you can also use ArcGIS formatting tags in label
expressions. These are special characters that you can use to change the appearance of all or part of
your labels. For example, you might use the bold formatting tag to make the first line bold in a stacked,
multiline label.

A label expression is limited to a single line of code, unless you check the Advanced box on the Label
Expression dialog box. Checking the Advanced box allows you to enter a function containing
programming logic and spanning multiple lines of code. See ‘Specifying the text of labels’ earlier in this
chapter for more information on applying label expressions.

Examples are shown below for common uses of VBScript functions as well as ArcGIS formatting tags in
label expressions. In addition, a complete reference of the ArcGIS formatting tags is provided.

Examples of label expressions

The following are examples of label expressions:

Use the VBScript & operator to concatenate strings. For example, this expression creates a label where
the value of the PARCELNO field is preceded by the text "Parcel no: ": "Parcel no: " & [PARCELNO]

To control how decimal numbers are displayed, use the VBScript Round function. For example, this
expression displays a field called Area rounded to one decimal place: Round ([AREA], 1)

To convert your text labels to all uppercase or lowercase, use the VBScript UCase and LCase functions.
For example, this expression makes a Name field all lowercase: LCase ([NAME])

To create stacked text, use the VBScript vbNewline or vbCrLf constants between the field names:
"Name: " & [NAME] & vbNewlLine & [ADDRESS 1] & vbNewline & [ADDRESS_2]

Use the VBScript format functions to format your labels. For example, this expression displays the label
as currency: "Occupancy Revenue: " & FormatCurrency ([MAXIMUM_OC] * [RATE])

This VBScript function labels cities with their name only if their population exceeds 250,000:
Function FindLabel ([NAME], [POPULATION])
if [POPULATION] > 250000) then
FindLabel = [NAME]
end if
End Function

ArcGIS text formatting tags: Labels will be drawn using the symbol specified in the Label Manager
or on the Labels tab of the Layer Properties dialog box You can modify or override the appearance of
this symbol for particular portions of the expression by inserting ArcMap text formatting tags into the
expression as text strings. This lets you create mixed-format labels where, for example, one field in a

73 Comprehensive Disaster Management Programme (CDMP 1l), DMRD, MoFDM



ArcGIS Basic

label is underlined. You can even use tags with curved text. The tags that you can use are listed in the
table below. Acceptable values for Color (RGB) are red, green, blue = 0-255, and acceptable values for
Color (CMYK) are cyan, magenta, yellow, black = 0-100; missing color attributes are assumed to be 0.
The defaults are 0 percent for Character spacing (no adjustment), 100 percent for Character width
(regular width) and Word spacing (regular spacing), and 0 points for Line leading (no adjustment).

Formatting action Tag syntax

Font "<FNT name='aArial' size='18'>" & [LABELFIELD] & "</FNT="
"<FNT name="'aArial' scale='200'=" & [LABELFIELD] & "</FNT="

Color (RGB) "<CLR red="255" green="255" blue="255">" & [LABELFIELD] & "</CLR>

Color (CMYK) "<CLR cyan="100"' magenta="100" yellow="100" black="100">"
& [LABELFIELD] & "</CLR>"

Bold "<BOL>" & [LABELFIELD] & "</BOL="

Italic "<ITA>" & [LABELFIELD] & "</ITA>"

underline "<UND>" & [LABELFIELD] & "</UND>"

A1l capitals "eACP>" & [LABELFIELD] & "</aCPp="

small capitals "<SCP>" & [LABELFIELD] & "</SCP>"

Superscript "e5UP=" & [LABELFIELD] & "</sup="

Subscript "zSUB>" & [LABELFIELD] & "</SUB>"

Character spacing "<CHR spacing="25">" & [LABELFIELD] & "</CHR="

Character width "<CHR width="150">" & [LABELFIELD] & "</CHR="

word spacing "<WRD spacing="150'>" & [LABELFIELD] & "</WRD>"

Line leading "<LIN leading="12">" & [LABELFIELD] & "</LIN="

Un-Bold "« BOL>" & [LABELFIELD] & "</_BOL>"

un-Italic "o ITA>" & [LABELFIELD] & "</_ITA>"

uUn-underline "< UND=" & [LABELFIELD] & "</_UND="

Un-Superscript "< SUP>=" & [LABELFIELD] & "</_sSuUpP="

Uun-subscript "< SUB=" & [LABELFIELD] & "</ _SUB="

Tag syntax

The following syntax rules apply to tags in label expressions.

Just like other static text in label expressions, formatting tags must be surrounded by double quotes and
concatenated to other parts of the expression using the & operator:

"<BOL>" & [LABELFIELD] & "</BOL>"

Tags are not interpreted by VBScript/JScript. Instead, they are passed on to the ArcMap framework as
plain text, to be dynamically formatted as they are drawn. You don’t need to quote tags included inside
quoted strings:

"Current <BOL>status</BOL> of parcel: " & [LABELFIELD]

The ArcMap text formatting tags follow Extensible markup language (XML) syntax rules. Each start tag
must be accompanied by an end tag. Tags can be nested, but you must close the inner tag before
closing an outer tag:

"<BOL><UND>" & [LABELFIELD] & "</UND></BOL>"

The case of tag pairs must match exactly. So <BOL>...</BOL> is valid, as is <bol>...</bol>, but
<Bol>...</bol> is invalid.
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In label expressions, tag attributes must be surrounded either by single quotes (as shown in the table
above) or by two sets of double quotes. The following expression is equivalent to the FNT entry in the
table:

"<FNT name=""Arial"" size=""18"">" & [LABELFIELD]& "</FNT>" & and < are special characters and are
not valid in your text if formatting tags are used. Use the equivalent character codes &amp; and &It;
instead. For example, this expression displays the values of the label field inside < > characters:
"<ITA>&It;" & [LABELFIELD] & "></ITA>"

If you have special characters embedded in the values of the label field, you can replace them
dynamically using a simple label script:
Function FindLabel ([LABELFIELD])
NewsString = Replace([LABELFIELD],"&","&amp;")
FindLabel = "<ITA>" & NewString & "</ITA>"
End Function
Formatting tags can be embedded in the values of the field you use to label a layer’s features, whether
or not you use a label expression. In this way, you can change the format of any portion of a particular
value in a label field. In order to embed formatting tags, the label field must be of string type. Tags and
tag attributes
used in field values do not need to be surrounded by quotes, so the following are valid values for a label
field:
<ITA>Rochester</ITA>
<FNT size="'18"'>C</FNT>olorado
Tags aren’t recognized by the table of contents, Attribute table window, or Identify Results window, so
tags added to field values appear unformatted as raw text in these windows. For more information on
working with formatting tags, see ‘Using text formatting tags’ in this chapter.
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Module VII

Working with Tables

A table is a database component that contains a
series of rows and columns, where each row, or
record, represents a geographic feature—such as a
parcel, power pole, highway, or lake—and each
column, or field, describes a particular attribute of
the feature—such as its length, depth, cost, and so
on.
In this Module, you’ll learn how to:
* Elements of a table
® Opening a layer’s attribute table
e Loading existing tabular data onto
a map
® Arranging columns
e Controlling a table’s appearance
e Locating and viewing records
e Sorting records
e Selecting records
¢ Adding table with x,y coordinates
e Exporting records
e Summarizing data
e Adding and deleting fields
e Editing attributes
e Making field calculations
¢ About joining attribute tables
e Joining attribute tables
¢ Relating attribute tables
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Working with tables: A table is a database component that contains a series of rows and columns,
where each row, or record, represents a geographic feature—such as a parcel, power pole, highway, or
lake—and each column, or field, describes a particular attribute of the feature—such as its length,
depth, cost, and so on. Tables are stored in a database—for example, INFO™, Microsoft Access, dBASE®,
FoxPro®, Oracle®, and SQL Server™.

You’ll typically use tables in ArcMap to inspect the attributes of geographic features. From a table, you
can identify features with particular attributes and select them on the map. Over time, you might also
update the attributes to reflect changes to geographic features.

Tables can also store information related to features such as warehouse inventories, monthly sales
figures, and maintenance records. By joining this information to your spatial data, you can uncover new
patterns and relationships that were not apparent before. For example, you might see which stores
have the top monthly sales figures, what roads require maintenance in the near future, or where the
largest number of endangered species is located.

Elements of a table

Columns or fields
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Opening a layer’s attribute table: To explore the attributes of a layer on a map, open its attribute
table. Once open, you can select features and find features with particular attributes.

You can open more than one table at a time. For example, you can view an attribute table of
administrative boundaries and, at the same time, view the attribute table for cities.
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Opening a layer’s attribute table

1. In the table of contents, rightclick the layer
for which you want to display a table.

2. Click Open Attribute Table. The layer’s
attribute table opens.
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Loading existing tabular data onto a map

1. Click the Add Data button.

2. Navigate to the table you want to add and

click it.
3. Click Add.

4. Click the Source tab at the bottom of the

table of contents.

5. Right-click the table and click Open.
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Changing a column’s width

1. Position the mouse pointer at the edge of
the column you want to resize.
The pointer’s icon changes.
2. Click and drag the column’s edge to the
desired width.
A black line indicates where the edge of the
column will be located.
3. Drop the edge of the column.
The column is resized.
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Changing a column’s position

1. Click the heading of the column you want to
move.
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Freezing a column

1. Click the heading of the column(s) you want
to freeze.

2. Right-click the selected column’s heading
and click Freeze/Unfreeze Column to freeze
the column.

The column is now frozen.

Setting the text font and size for a table

1. On the table window, click Options and click
Appearance.

2. Click the Table Font dropdown arrow and
click the font you want to use.

3. Click the Table Font Size dropdown arrow
and click a point size.

4. Click OK.
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Setting the default text font and size for all tables
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1. Click the Tools menu and click Options.
. Click the Tables tab.
3. Click the Table Font dropdown arrow and

N

click the font you want to use. R (L
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4. Click the Table Font Size dropdown arrow e — '3
and click a point size. e FontimmiColr 15 o] [_IE} o

5. Click OK.
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1. On the table window, click Options and click = e
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Setting the default selection and highlight color for all tables

1. Click the Tools menu and click Options. g g
2. Click the Tables tab. Saleme i
3. Click the selected records dropdown arrow K’"E"”.’.T‘...,"‘l‘m L _] O
and click the color you want to use. i e— 0
4. Click the highlighted records dropdown B ,...T.,..g
arrow and click the color you want to use. A
5. Click OK. Fil gt ot
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Formatting numeric fields

1. Right-click the layer or table in the table of
contents and click Properties.

2. Click the Fields tab.

3. Click a numeric field in the list.

4. Click the button in the Number Format
column. Only numeric fields have this i

button. g_o

5. Set the number of decimal places, alignment,
and so on.
6. Click OK on the Number Format dialog box. e o ke
T oy Py I |
7. Click OK when finished. Ay e Bl

C =N . N = . e
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Moving to a specific record number

1. Open the table.

2. Type the number of the record you want to N —LONTRY |G
move to and press Enter. {0 0da sndNogar Havel [k [Ase
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:[ah:n .Hm: ..ﬁ.'.u
'_.L.mr-_'w .‘.-yr-u A
Daks [Inda | As
:l"lni F :E!qu:r I 5
'_.[D"'\lDd | Mangoks .ﬁ.'.l
4] EE—
Receed 1] 4 16 #|M| Show | &0 Selocted | Records [0 ol
[ s

Maove to first record J é |— Mowve to last record

Pravious record Naxt recond
Viewing all or only the selected records
1. Open the table. Dabon Mongala _"n:a;
2. Click Show All to view all records or click gﬂ{:ﬂa"" f?d'f‘“ =
el ndia 38
Show Selected to view only the selected Dhaka Bangiadesh | i
ones. Domod Mongolia Az
4

Recoid: 14] 4] 165 #|»] Show: | A1 Selected | Recoids (0 out

- [t S

)
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Finding records with particular attribute values

1. Click the heading of the column that contains
the text for which you want to search.

2. Click Options and click Find & Replace. e LN | sou
3. Type the text you want to find in the Find e m e — °_
what text box. BE= o— L et
4. Click the Text Match dropdown arrow and ow <2 e i
click the type of search you want. = e e
5. Click Find Next. T e wr bt |
The first record found containing your text is Lovss ZE_ 1w B
selected. E; = ':"' s O PemiCae
6. If you want to find another record containing o = N
the same text, click Find Next again. i—-um.d__um St [t e i S| G|
7. Click Cancel to close the dialog box.
(2
Fed | fagiece]
i oo 2 _titea |
Tty [ =] g A

Goarh Do =] Seach (g Selecked Fiskdi|
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Sorting records by one column

1. Click the heading of the column whose
values you want to use to sort the records.
2. Right-click the selected column’s heading

and click Sort Ascending or Sort Descending.

The table’s records are sorted.
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The racords are sorted according
to the selected column's values.
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Sorting records by more than one column

1. Rearrange the table’s columns so the column

whose values will be sorted first appears to
the left of the column whose values will be
sorted second.

2. Click the heading of the first column you
want to use to sort the records.

3. Press the Ctrl key on the keyboard and click
the second column’s heading.

4. Repeat step 3 until you’ve selected all
columns that will be used to sort the table’s
records.

5. Right-click a selected column heading and
click Sort Ascending or Sort Descending.

The table’s records are sorted
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The records are sorted first by the left column's
values, then by the right column's valuas.
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Interactively selecting records

1. Open the attribute table for a layer on your
map.

2. Click the leftmost column in the table
adjacent to the record you want to select.
To select consecutive records, you can click
and drag the mouse.

3. Press and hold the Ctrl key while clicking
additional records
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.9 Selected records are highlighted in
the table and on the map.
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Selecting records by attributes

1. Click Options in the table you want to query ) s
and click Select By Attributes. E[ i 3 D “m:i:“

2. Click the Method dropdown arrow and click = - R
the selection procedure you want to use. Z S::'.:_

3. Double-click the field from which you want = ~ —
to select. o T

4. Click the logical operator you want to use. e e

5. Click the Get Unique Values button, then EI o SR e
scroll to and double-click the value in the B = s
Unique Values list you want to select. Mestuiaf el Senl bk Bttt ] |
Alternatively, you can type a value directly (1)

into the text box.
6. Click Verify to verify your selection.

7. Click Close. Envera WHERE chause 1 sfisc eccrs i e tale windo
Your selection is highlighted in the table. E oo & 1o Joctn 0
Use Apply if you intend to run more than S R Lt
one query or if you want to check your Sanne |15 e el |1
results before closing the Select By --':.I?:-:-Ii-i;::r’l.:i" e o [
Fv’_NAME' s |
Attributes dialog box. mone wave | SELS| S| e s g
S g0 L —
SELECT * FRIOM courtry WHEFE
FOP_CHTRY » 10000 e

Oom | Ve | deb | o | e |
Lo ] o= |

@
[~

Selecting all records

1. Click Options in the table and click Select All.

T

ﬂl—-nu-ms—u _M
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Clearing the selected set

1. Click Options in the table and click Clear
Selection.

Switching the selected set

1. Click Options in the table and click Switch
Selection.

Adding a table with x,y coordinates

1. Click Tools on the Main menu and click Add
XY Data.

2. Click the table dropdown arrow and click a
table that contains x,y coordinate data. If
the table is not on the map, click the
Browse button to access it from disk.

3. Click the X Field dropdown arrow and click
the field containing x coordinate values.

4. Click the Y Field dropdown arrow and click
the field containing y coordinate values.

5. Click Edit to define the coordinate system
and units represented in the x and y fields.
The x,y coordinates will be automatically
transformed to match the coordinate
system of the data frame.

6. Click OK.
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Exporting records

1. Click Options in the table you want to export. %
2. Click Export_ i i I:.' . .I.,f. :::c::-
3. In the Export Data dialog box, click the : 3?.":...

RS,

Export dropdown arrow to choose to export
Selected records or All records.

T [t "
El Conme leagin.
k] T s b Lt

This option is only available if records are o

selected in the table you want to export. " pa ——
but a0 blel] e[ e | e B B ] [y

4. Click the Browse button and navigate to the 6
folder or geodatabase in which you want to
place the exported data.

5. Click the Save as type dropdown arrow and
click the format to which you want to export
the data. For example, click Personal
Geodatabase tables.

6. Type a name for the exported table.

7. Click Save.

8. Click OK.
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Summarizing data in a field

. Right-click the field heading of the field you
want to summarize and click Summarize.

. Check the box next to the summary statistics
you want to include in the output table.

. Type the name and location of the output
table you want to create or click the Browse
button and navigate to a workspace.

4. Click OK.

5. Click Yes when prompted to add the new

table to your map

Adding a field to a table

1. Click Options in the table you want to add a
field to.

2. Click Add Field.

3. Type a name for the field.

4. Click the Type dropdown arrow and click the
field type.

5. Set any other field properties, such as a field
alias, as necessary.

6. Click OK.

ArcGIS Basic
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Deleting a field from a table

1. In the table window, right-click over the field
header of the field you want to delete.

2. Click Delete Field.

3. Click Yes to confirm the deletion.

Deleting a field cannot be undone.

E ey, ey sl et L
T8 R TN L Y T i T e e

00— =&l

Editing text in records

1. If you haven’t started an edit session, click

the Editor menu on the Editor toolbar and m

click Start Editing.
2. Open the table you want to edit. 3
3. Click the cell containing the attribute value

you want to change. T — '.""'"'";H""‘.’*‘“f' e
4. Type the values and press Enter. i e o o T—

: -y s o TG
The table is updated. T = - o
bt 1A sl e[ S et Pt |4

Adding new records

1. If you haven’t started an edit session, click EM
the Editor menu on the Editor toolbar and
click Start Editing.

2. Open the table you want to edit.

3. Click Move to end of table.

4. Click a cell in the last, empty record and type
in a new value.

NOTE: Use these steps to add new records to
tables that don’t have associated geographic

features. If you want to add features to your 6 é
shapefile or geodatabase, use the Create

New Feature task on the Editor toolbar.
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Copying and pasting records

1. If you haven’t started an edit session, click
the Editor menu on the Editor toolbar and
click Start Editing.

2. Open the table you want to edit.

3. Select the records you want to copy. Press
and hold the Ctrl key while clicking to select
more than one record.

4. Click Copy on the Standard toolbar.

5. Click Paste on the Standard toolbar. The new
records are added at the end of the table.

Making simple field calculations

1. If you haven’t started an edit session, click
the Editor menu on the Editor toolbar and
click Start Editing.

You can make calculations without being in
an edit session; however, in that case, there
is no way to undo the results.

2. Open the table you want to edit.

3. Select the records you want to update. If you
don’t select any, the calculation will be
applied to all records.

4. Right-click the field heading for which you
want to make a calculation and click
Calculate Values.

5. Use the Fields list and Functions to build a
calculation expression. You can also edit the
expression in the text area below.
Alternatively, you can just type in a value to
set the field to. In this example, the string
“Single Family” is used.

NOTE: Use double quotes when calculating
strings.
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6. Click OK. ey e
7. Don’t forget to end your edit session. Click I Tt
the Editor menu and click Stop Editing. G—F

Making advanced field calculations

1. If you haven’t started an edit session, click
the Editor menu on the Editor toolbar and
click Start Editing.

i Abibasies of | srcduns

You can make calculations without being in
an edit session; however, in that case, there L
is no way to undo the results. e e (e le
2. Open the table you want to edit. e SO ol izl st o
3. Select the records you want to update. If you -
don’t select any, the calculation will be Tow. Tl
applied to all records. :::' ! j
4. Right-click the field heading for which you Fpee =)
want to make a calculation and click =i =
Calculate Values. ] s
5. Check Advanced. ST = I I F5)
6. Type VBA statements in the first text box. 2 i = %II
The VBA statements can include ArcMap o ems - g |
methods. The VBA code shown in the figure — S e
gets the x coordinate of the centroid of each Q- S|

polygon in the layer and writes it out to a
field called X_FIELD.

7. Type the variable or value that is to be
written to the selected records.

8. Click OK.
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Joining the attributes in one table to another

1. Right-click the layer or table you want to —
join, point to Joins and Relates, and click Join. ripa
2. Click the first dropdown arrow and click Join -,.,M-M_
attributes from a table. 0 homega X e
3. Click the second dropdown arrow and click o
the field name in the layer that the join will sl e
be based on. ;‘_‘:“" . i
4. Click the third dropdown arrow to choose | - anTvan
the table to join to the layer. If the table is ggt::‘:::':

not currently part of the map, click the
Browse button to search for it on disk.

=rrn (1] =]
5. Click the fourth dropdown arrow and click e e S S
the field in the table to base the join on. S Eryred BN i
e’—..l T _:j
6. Click OK.
1 Cliried o bl 2 o b et i sl b B i
O— 3
The attributes of the table are appended to e e
the layer’s attribute table O+ - i

5 s P i o o s o B

¥ Clemen tom i e b b e o o o

b _ﬂ

T

s gt | o |t |

Removing a joined table

want to remove and point to Joins and "2 bes
Relates. & [FrEm—
2. Point to Remove Join(s) and click the join you DX fenere

] Openlstaie Latie
want to remove EETTE - |
@ Zeon ToLum | fience sortil |

1. Right-click the layer containing a join you —_;Lw—”

Eiapved Latels to Annoiafion
SF Cormen Entluns ko Gonphcs

Qe "

Save As Lager Fle
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Managing joined tables

1. Right-click a layer or table in the table of
contents and click Properties.
2. Click the Joins & Relates tab.

All the joins for the layer or table are listed
on the left side of the dialog box. You can
add new joins or remove existing ones.

vl | T | Sawcnon | Enpany | amesotg | Tt | s oy | Lot | e Pk |
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i) Pt &1
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Relating the attributes in one table to another

1. Right-click the layer you want to relate, point
to Joins and Relates, and click Relate.

2. Click the first dropdown arrow and click the
field in the layer, the relate will be based on.

3. Click the second dropdown arrow and click
the table or layer to relate to, or load the
table from disk.

4. Click the third dropdown arrow and click the
field in the related table to base the relate
on.

5. Type a name for the relate.

You’ll use this name to access the related data.
6. Click OK.
The relate is now established between the

two tables. The next topic discusses how to
access records using the relate.

All joins for the layer or table are listed here
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Accessing related records

1. Open the attribute table for which you’ve set
up a relate.

2. Select the records in the table for which you
want to display related records.

3. Click Options, point to Related Tables, and
click the name of the relate you want to
access.

The related table displays with the related
records selected

Removing a related table

1. Right-click the layer containing a relate you
want to remove and point to Joins and
Relates.

2. Point to Remove Relate(s) and click the
relate you want to remove.

Managing related tables

1. Right-click a layer or table in the table of
contents and click Properties.
2. Click the Joins & Relates tab.

All the relates for the layer or table are listed
on the right side of the dialog box. You can
add new relates or remove existing ones.
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All relates for the layer or table are listed here.
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Module VIiI

Querying Maps

Maps convey a great deal of information. You can

learn a lot about an area just by looking at a map.

Yet, sometimes those things that are most

interesting and revealing are not immediately

apparent by looking at a map. You can begin to

discover new spatial relationships when you start

asking questions such as: Where is...? Where’s the

closest? What’s inside? And What intersects?

In this Module, you’ll learn how to:

e Displaying MapTips

e |dentifying features

e Hyperlinking

e Selecting features interactively

» Selecting features by searching with a SQL
expression

e Building a SQL expression
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Displaying MapTips

1. In the table of contents, rightclick the layer
for which you want to display MapTips and

click Properties. g,.._'":*‘_;:::._:.'::.:”' B
2. Click the Display tab and check Show S

MapTips. P% bt o —
3. Click the Fields tab. T e [T i Ty
4. Click the Primary Display Field dropdown P——— = 2 ]

arrow and click the attribute field you want =¥
to display as the MapTip. — e ey

5. Click OK. g’;i_l
6. Move the mouse pointer over a feature to
see the MapTip.

Creating and accessing hyperlinks stored in a layer file or ArcMap document

1. Click the Identify button on the Tools e =t
toolbar. Daaa i tex . ¢ oo Sk {-lL] :
2. Click a feature. 'F“- P
3. In the Identify Results window, right-click the -
feature you want to set a hyperlink for and (1 I
click Add Hyperlink. 0 oE
4. To add a hyperlink to a Web page, click Link :
toa URL and type a URL. To link to a i -
document, click Link to a Document and : e s
type a pathname to the document. " e
5. Click the Hyperlink tool on the Tools toolbar i SIS o (R
and click a feature. _— Jj“m.’ et
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Using an attribute field as a hyperlink

1. In the table of contents, rightclick the layer
containing a field with hyperlinks and click
Properties.

2. Click the Display tab.

3. Check Support Hyperlinks using field. Click
the dropdown arrow and click a field.

4. Click Document or URL.

5. Click OK.

6. On the Tools toolbar, click the Hyperlink
button.

7. Move the mouse pointer over a feature and
click to display the hyperlink.

Making the Selection tab visible

1. Click Tools on the Main Menu and click
Options.

2. Click the Table Of Contents tab.

3. In the Table Of Contents tab options, check
the Selection box.

4. Click OK
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Selecting a feature by clicking it in the map

1. Click the Selection tab in the table of
contents.

2. Click the layers you want to select from.

3. Click Selection, point to Interactive Selection
Method, then click Create New Selection.

4. Click the Select Features tool.

. Click the feature you want to select.

6. To select additional features, hold down the
Shift key while clicking the features.

(S, ]

To remove a feature from the selected set, click
the Selection menu, point to Interactive
Selection Method, and click Remove From
Current Selection. Click a selected feature and
it is deselected.

Select features by dragging a box

1. Click the Selection tab in the table of
contents.

2. Click the layers you want to select from.

3. Click Selection in the Main Menu, point to
Interactive Selection Method, then click Create
New Selection.

4. Click Selection in the Main Menu and click
Options.

5. Specify how you’d like to select features with
the box and click OK.

6. Click the Select Features button.

7. Click and drag a box around the features you
want to select.

8. To select additional features, hold down the
Shift key as you drag the box.

To remove a feature from the selected set, click
the Selection menu, point to Interactive
Selection Method, and click Remove From
Current Selection. Drag a box around the
features you want to deselect.

e o s
=
s
9—! Tt b o ik 0 i o P a1 e |
L e
17 Tt b g b o el o m—y g

T e e st e e e s

:“_n-l'_-.-:ﬂlﬁbo

s
S
.

==

ey [mtua

T [oann s=wrun o pmmay T oF 8 S L
Fu e b ¢ gree B P Foichan

L

T e o b e

103 Comprehensive Disaster Management Programme (CDMP Il), DMRD, MoFDM



ArcGIS Basic

Selecting a feature by clicking it in the table

1. Right-click a layer in the table of contents
and click Open Attribute Table.

2. Select a feature in the table by clicking to the
left of a record.

3. To select additional features, hold down the
Ctrl key and click the features. To deselect a
feature, hold down the Ctrl key and click the
feature.

Search by attribute

1. Click Selection and click Select By Attributes.
2. Click the Layer dropdown arrow and click the
layer containing the features you want to
select.

3. Click the Method dropdown arrow and click
a selection method.

4. Double-click a field to add the field name to
the expression box.

5. Click an operator to add it to the expression.
6. Click Get Unique Values to see the values for
the selected field. Double-click a value to add it
to the expression.

7. To see if you're using proper syntax or if the
criteria you’ve entered will select any

features, click the Verify button.

8. Click Apply.

The status bar at the bottom of the ArcMap
window tells you how many features are
selected.

9. If you're finished selecting features, click
Close.
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Module IX

GPS and Georeferencing

To georeference something means to define its
existence in physical space. That is, establishing its
location in terms of map projections or coordinate
systems. The term is used both when establishing the
relation between raster or vector images and
coordinates but also when determining the spatial
location of other geographical features. Examples would
include establishing the correct position of an satellite
image within a map or finding the geographical
coordinates of a place name or street address. This
procedure is thus imperative to data modeling in the
field of geographic information systems (GIS) and other
cartographic methods. When data from different sources
need to be combined and then used in a GIS application,
it becomes essential to have a common referencing
system.

In this Module, you’ll learn how to:

e GPS field Survey

¢ Creating Waypoints

e Creating Tracks

e About georefrencing

e Aligning the raster with control point

¢ Transforming the raster

e Interpreting the root mean square error

® Resampling the raster datasets

e Raster rectification

» Georeferencing a raster dataset

* Hands-on exercises
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GPS Field Survey

For this survey, you will use Magellan Triton
400 handheld GPS. You will record some point
feature (office, mosque, ATM etc) and line
feature (road, canal, telephone line, sewerage
line etc). You can also capture Ground Control
Point with GPS for next exercise of how to
perform georeferencing. As you will go outside
of a building or shaded area, your GPS will get
information from available satellite at this
point. You will see battery icon at the upper left
corner of the GPS screen that denotes Battery
(Power) strength and in the upper right
corner’s bar indicate the strength of satellite
signals. At indoor, it remains deemed (light red
color), which means there is no satellite signal
and at outdoor, after some time, it will show
green colored bar, which means GPS is
receiving signal from sufficient number of
Satellites (at least 4) to fix a position on the
ground.

Satellite Status Screen

Using PAGE / GO TO button, you can navigate
to satellite status screen. The Satellite Status
Screen graphically displays the satellites and
their signal strength that is being used to
compute your location. This screen shows
when you are getting strong, weak, or poor
signal reception. Green satellite icons represent
satellites that are being used to compute your
position while yellow (good), white (medium),
and red (poor) icons show signal strengths of
other available satellites. Signal levels are also
represented at the bottom of the screen as
colored bars.

The numbers indicate the GPS satellite ID.

MAGELLAN-,

Magellan Triton

Backlight Bulion

Power Bution

Zoom - (Zoom out) Button

Zoom + (Zoom inp Button

ENTER Buttarn [ Cursor Control

PAGE / GO TO Button

Exsc {Escapa) Bution

Menu Button

SD Card Slot (under protective rubber cover)

-~ TOmMmMmoOonoPE

B F
5[50 (2
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k - -
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Creating Waypoints

1. Press ENTER.

2. Select Create Waypoint to capture point
feature or POI (Point of Interest)

3. Edit the waypoint as desired. Use the cursor
control UP or DOWN to highlight the field
you want to edit and press ENTER. Use the
cursor control LEFT or RIGHT to select the
page you want to edit. (Available pages are
Information, Media, and Alerts.)

4. When the edits, if any, are done, use the
cursor control UP or DOWN to highlight the
save to disk button (highlighted in the screen
to the right). Press ENTER

Viewing a saved Waypoint

From the Map screen, press MENU.

Select Go To.

Select Waypoint

You will get a list of waypoint (s) if there are
existing saved waypoints.

PwnNpE

= 05:00 AM all

Sort by: Nearest v

E— —% WFOOO!
2. & WPOO0 pre

| & WPO00? =

|g WPOO0S
& WPrODO7
® WPOOO4

& Wro03
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Creating Track (Line feature)

1.
2.

Press ENTER.
Select Start New Track to capture line
feature.

3. Click Yes as you will be asked for Clear Active

Track & Start New Track. Now start walking
along the alignment of the feature you want
to capture. There are two options for fixing
coordinates automatically by distance or by
time. As we will take both point and line
features using the same GPS, it is better to
choose option by distance. If we select 10m
interval, then GPS will store coordinates
after each 10m traveling to draw the
track/path/trail.

4. After finishing your travel again Press ENTER

and choose save track from the menu to
store your alignment.

Viewing a saved Track

PwwnNpE

From the Map screen, press MENU.

Select Go To.

Select Trail

You will get a list of Trail (s) if there are
existing saved Trails.
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About Georeferencing

Raster data is commonly obtained by scanning maps or collecting aerial photographs and satellite images.
Scanned map datasets don't normally contain spatial reference information (either embedded in the file
or as a separate file). With aerial photography and satellite imagery, sometimes the locational information
delivered with them is inadequate and the data does not align properly with other data you may have.
Thus, to use some raster datasets in conjunction with your other spatial data, you may need to align, or
georeference, to a map coordinate system. A map coordinate system is defined using a map projection (a
method by which the curved surface of the earth is portrayed on a flat surface).

When you georeference your raster dataset, you define its location using map coordinates and assign a
coordinate system. Georeferencing raster data allows it to be viewed, queried, and analyzed with other
geographic data

The general steps for georeferencing a raster dataset are:

1. Add the raster dataset that you want to align with your projected data in ArcMap.

Add control points that link known raster dataset positions to known positions in map coordinates.

3. Save the georeferencing information when you’re satisfied with the alighnment (also referred to as
registration).

4. Optionally, permanently transform the raster dataset.

N

Aligning the Raster with Control Point

Generally, you will georeference your raster dataset using existing spatial data (target data), such as a
vector feature class, that resides in the desired map coordinate system. The process involves identifying a
series of ground control points—known x,y coordinates—that link locations on the raster dataset with
locations in the spatially referenced data (target data). Control points are locations that can be accurately
identified on the raster dataset and in real-world coordinates. There are many different types of features
that can be used as identifiable locations, such as road or stream intersections, the mouth of a stream, the
corner of a building etc.

The control points are used to build a polynomial transformation that will convert the raster dataset from
its existing location to the spatially correct location. The connection between one control point on the
raster dataset (the from point) and the corresponding control point on the aligned target data (the to
point) is a link.

The example below shows a from control point (yellow cross) placed on the vector target data at a street
crossing and the associated control point (green cross) placed on the raster dataset. The associated link is
represented by the blue line joining the control points.
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The number of links you need to create depends on the complexity of the transformation you plan to use
to transform the raster dataset to map coordinates. However, adding more links will not necessarily yield
a better registration. If possible, you should spread out the links over the entire raster dataset rather than
concentrating them in one area. Typically, having at least one link near each corner of the raster dataset
and a few throughout the interior produces the best results.

Generally, the greater the overlap between the raster dataset and target data, the better the alignment
results because you’ll have more widely spaced points with which to georeference the raster dataset. For
example, if your target data only occupies one-quarter of the area of your raster dataset, the points you
could use to align the raster dataset would be confined to that area of overlap. Thus, the areas outside the
overlap area are not likely to be properly aligned.

Keep in mind that your georeferenced data is only as accurate as the data to which it was aligned. To
minimize errors, you should georeference to data that is at the highest resolution and largest scale for
your needs.

Transforming the Raster

When you've created enough links, you can transform—or warp—the raster dataset to permanently
match the map coordinates of the target data. You have the choice of using a polynomial, spline, or adjust
transformation to determine the correct map coordinate location for each cell in the raster.

The polynomial transformation uses a polynomial that is built upon control points and a least square
fitting (LSF) algorithm. It is optimized for global accuracy but does not guarantee local accuracy. The
polynomial transformation yields two formulas: one for computing the output x-coordinate for an input
(x,y) location and one for computing the y-coordinate for an input (x,y) location. The goal of the least-
square fit is to derive a general formula that can be applied to all points, usually at the expense of slight
movement of the to positions of the control points. The number of the noncorrelated control points
required for this method must be 3 for a first order, 6 for a second order, and 10 for a third order. The
first-order polynomial transformation is commonly used to georeference an image.
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Below is the equation to transform a raster dataset using the affine (1st order) polynomial transformation.
You can see how six parameters define how a raster's rows and columns transform onto map coordinates.

i : g}; 1 %3 I E map units: meters, feet, other
AY A
display units: pixels = IE
® columnsl
Y

Image space

C > x

Coordinate space

% is column count in image space.

¥ is row count in image space.

¥' is horzontal value in coordinate space.
y' is vertical value in coordinate space.

A is width of cell in map units.

B is a rotation term.

C is the x' value of the center of upper-right cell,
D is a rotation term.

E is negative of height of call in map units.

Fis the y' value of the center of upper-right cell.

Interpreting the root mean square error

When the general formula is derived and applied to the control point, a measure of the error—the
residual error—is returned. The error is the difference between where the from point ended up as
opposed to the actual location that was specified—the to point position. The total error is computed by
taking the root mean square (RMS) sum of all the residuals to compute the RMS error. This value
describes how consistent the transformation is between the different control points (links). When the
error is particularly large, you may want to remove and add control points to adjust the error.

Although the RMS error is a good assessment of the accuracy of the transformation, don’t confuse a low
RMS error with an accurate registration. For example, the transformation may still contain significant
errors due to a poorly entered control point. The more control points of equal quality used, the more
accurately the polynomial can convert the input data to output coordinates. Typically, the adjust and
spline transformations give an RMS of near zero or zero; however, this does not mean that the image will
be perfectly georeferenced.

111 Comprehensive Disaster Management Programme (CDMP Il), DMRD, MoFDM



ArcGIS Basic

Resampling the raster dataset

When you rectify or transform a raster dataset, project it, resample it, convert the raster dataset from one
projection to another, or change the cell size, you are performing a geometric transformation. Geometric
transformation is the process of changing the geometry of a raster dataset from one coordinate space to another.
Types of geometric transformations include rubber sheeting (usually used for georeferencing), projection (using the
projection information to transform the data from one projection to another), translation (shifting all the
coordinates equally), rotation (rotating all the coordinates by some angle), and changing the cell size of the dataset.

After the geometric transformation is applied to the input raster, the cell centers of the input raster rarely line up
with the cell centers on the output raster; however, values need to be assigned to the centers.

Although you might think each cell in a raster dataset is transformed to its new map coordinate location, the
process actually works in reverse. During georeferencing, a matrix of empty cells is computed using the map
coordinates. Then, each empty cell is given a value based on the resampling process.

The three most common resampling techniques are nearest neighbor assignment, bilinear interpolation, and cubic
convolution. These techniques assign a value to each empty cell by examining the cells in the ungeoreferenced
raster dataset

Nearest neighbor assignment is the fastest resampling technique and is appropriate for categorical or thematic
data, since it does not alter the value of the input cells. Once the location of the cell’s center on the output raster
dataset is located on the input raster, nearest neighbor assignment determines the location of the closest cell
center on the input raster and assigns the value of that cell to the cell on the output raster.

The nearest neighbor assignment does not change any of the values of cells from the input raster dataset. The value
2 in the input raster will always be the value 2 in the output raster; it will never be 2.2 or 3. Since the output cell
values remain the same, nearest neighbor assignment should be used for nominal or ordinal data where each value
represents a class, member, or classification—this may be categorical data such as a land-use, soil, or forest type.

Bilinear interpolation uses the value of the four nearest input cell centers to determine the value of the output
raster. The new value for the output cell is a weighted average of these four values, adjusted to account for their
distance from the center of the output cell in the input raster. This interpolation method results in a smoother-
looking surface than can be obtained using nearest neighbor.

Cubic convolution is similar to bilinear interpolation, except the weighted average is calculated from the 16 nearest
input cell centers and their values. Cubic convolution will have a tendency to sharpen the data more than bilinear
interpolation since more cells are involved in the calculation of the output value. Therefore, this resampling method
is often used when resampling imagery, such as aerial photography and satellite imagery.

Bilinear interpolation or cubic convolution should not be used on categorical data since the categories will not be
maintained in the output raster dataset. However, all three techniques can be applied to continuous data, with
nearest neighbor producing a blocky output, bilinear interpolation producing smoother results, and cubic
convolution producing the sharpest results.
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Should you rectify your raster

You can permanently transform your raster dataset after georeferencing it by using the Rectify command on the
Georeferencing toolbar or by using the Warp tool. You can also store the transformation information separately in a
new file using the Update Georeferencing command on the Georeferencing toolbar

Rectifying or warping will create a new raster dataset that is georeferenced using the map coordinates and the
spatial reference. You can save this as a GRID, IMG, TIFF, BMP, GIF, JPEG, JPEG 2000, or PNG format. ArcGIS doesn’t
require you to permanently transform your raster dataset to display it with other spatial data; however, you should
choose to if you plan to perform analysis with it or want to use it with another software package that doesn’t
recognize the external georeferencing information created in the world file

Updating the georeferencing will store the transformation information in external files—it will not create a new
raster dataset, which is what happens when you permanently transform your raster dataset.

Georeferencing a raster dataset

Method A: Using Referenced Dataset

Start ArcMap.

Add the layers residing in map coordinates and the raster dataset you want to georeference.

In the table of contents, right-click a target layer (the referenced dataset) and click Zoom to Layer.
From the Georeferencing toolbar, click the Layer drop-down arrow and click the raster layer you
want to georeference.

El e

Georeferencing

Gooreferencng ¥ | Laver: [las_vegariimg x| I = i
| | |
Update aferancing
e £ Rokate Rioht =) = |
Rectify... 7
A4S Rotske Lokt :
it To Display |
A\ Fip Horizonkal e
fieot Botetn ' 2 movetial
Transformation —
¥ Lst Order Polyramial (Affine)
¥ fto Adpst 2nd Order Polyriomizl
3rd Order Pohymomial
Adjust
Rgset Transfermation Sploe

Georeferencing toolbar buttons and their functions

Button Name Function
Rotate Rotates the source layer.
®
& Shift Shifts the source layer.
i Scale Rescales the source layer.
" Add Control Points Allows you to select control points from a layer and add them to the map.
"
= View Link Table Shows inks and errors in tabular form.
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Click Georeferencing and click Fit To Display.

This will display the raster dataset in the same area as the target layers. You can also use the Shift
and Rotate tools to move the raster dataset as needed. To see all the datasets, you may have to
adjust their order in the table of contents.

Click the Add Control Points tool -'/Fto add control points.
To add a link, click the mouse pointer on a known location on the raster dataset, then on a known
location on the data in map coordinates (the referenced data).

You may find it useful to add your links in a Magnification window. When working with two raster
datasets, you may want to open the Effects toolbar and adjust the transparency or turn layers on
and off in the table of contents to view each image as you add your links.

Add enough links for the type of transformation.

You need a minimum of three links for a spline or 1st-order polynomial (affine), six links for a 2nd-
order polynomial, and ten links for an affine or 3rd-order polynomial.

Click View Link Table to evaluate the transformation.

You can examine the residual error for each link and the RMS error. If you're satisfied with the
registration, you can stop entering links.

Click Georeferencing and click Update Georeferencing to save the transformation information with
the raster dataset.

This creates a new file with the same name as the raster dataset but with an .aux.xml file
extension. It also creates a world file for some of the file formats, including .tif and .img files.

Method B: Using Specific X,Y Map Coordinates

b

Click View Link Table on the Georeferencing toolbar.

Click the Add Control Points tool */F

Click the mouse over the known location in the unreferenced image to add the first coordinate in
the link.

Right-click the image and click Input X and Y.

Enter the reference coordinates on the Enter Coordinates dialog box.

Click OK.

Hands-on exercise using method B
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Collection of Satellite Image

Google Earth (GE) is a very good source for high resolution image. It is free so far. For this georeferncing
exercise, a portion of Dhaka City is saved from GE and then four distinct locations are identified for control
points. These control points (CP) can also be managed from GPS field survey. For Example, the following
image is showing four control points like GCP1...GCP4. But you are advised to select by your own choice.
Now open an excel file and put the for CP to convert Degree-Minute-Second to Degree Decimal

GCP X Y X Y
D M S D M S
1 90 21 40.69 23 48 41.2 90.3613 23.81144
2 90 22 14.19 23 48 50.92 90.37061 23.81414
3 90 22 24.81 23 48 24.68 90.37356 23.80686
4 90 21 47.66 23 48 16.63 90.36324 23.80462
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If you want to do georeferencing for images other than Google Earth, which you have purchased or
collected from RS datasets providers, you could also get CP from GE. Other sources of CP are GPS survey
or already georeferenced vector or raster datasets.

1. Now open the image to be georeferenced Geonefencing @l
in ArcGIS using Add Data button. Georelerencing = | Layer. [Mepur g =l @[/ 3|
2. Identify at least four control points on the
image

3. Find corresponding locations on GE and get
Lat/Lon for those locations; if Lat/Lon is in
DMS, convert it to degree decimal with
excel spreadsheet [follow the example
given in previous page. The Lat/Lon of
those CPs can also be taken from GPS field
Survey or from already georeferenced
Vector/Raster data of the same area.

4. Open georeferencing tool bar if it is not
already there by clicking view — toolbars —
georeferencing

5. Click Add Control Points button from
Georeferencing Tool Bar

6. Click the Cross Hair at the first CP and then
right click first and then left click on the
option Input X and Y... to enter the value of
X (lon) and Y (lat), which you have got from
GE or GPS field survey.

7. Follow step 5-6 for the rest of the CPs.

8. After entering the values of all CPs, click
View Link Table button to open table of

entered CPs and check Residual and RRMS Osorvlarniog : il
error to ensure the quality of CPs and |§mﬂ'rmmv il e = Ol J|
adjust accordingly, if needed by deleting
and entering new CPs. o

9. Click Georeferencing combo box and select Gearetarencing —_ N
Update Georeferencing to associate lat/lon L%“ =
information with the image. e

10. Georeferencing is done. o v Botate =

Transfosmation »

v Ao Adjis

Now you can exercise Method A for
georeferencing.
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Module X

Map Layout and Printing

Before you begin to symbolize data for a map, you’ll

need to think about how you want the map to look

when it’s printed or published.

You should consider questions such as:

e Will the map stand alone, or will it be part of a
series of maps that share a similar design?

e What size will the printed version of the map be?

* How will the page be oriented?

* How many data frames will the map have?

e Will the map have other map elements such as a
title, a North arrow, and a legend?

e Will the map contain graphs or reports to
complement the geographic view of the data?

e How will scale be indicated on the map?

¢ How will the map elements be organized?

In this Module, you’ll learn how to:

* About map templates

e Starting a map from a template

¢ Saving a map as a template

e Setting up the page

e Using rulers, guides, and grids

¢ Adding data frames

¢ Adding map elements related to data frames

¢ Creating grids and graticules

¢ Adding other map elements

¢ Printing a map

e Exporting a map
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Map Outputs

Laying out and printing maps:

You should consider questions such as:

e Will the map stand alone, or will it be part of
a series of maps that share a similar design?

e What size will the printed version of the map
be?

e How will the page be oriented?

e How many data frames will the map have?

e Will the map have other map elements such
as a title, a North arrow, and a legend?

e Will the map contain graphs or reports to
complement the geographic view of the
data?

* How will scale be indicated on the map?

e How will the map elements be organized on
the page?

The shape and orientation of the geographic
features you’re depicting may influence the
size and shape of the data frame on the map
as well as the orientation of the map on the

page.

Aesthetic criteria, limitations of the media
that you use to reproduce the map, and the
number and size of other elements that you
add to the map will bear upon your choice of
page size and orientation.

In addition to a data frame, most maps
contain one or more other map elements.
These include titles, North arrows, legends,
scale bars, scale text, graphs, reports, text
labels, and graphics.

RN AL |

About map templates: If you are creating a series of maps and it is important that they have the
same look and feel, you can use a map template to standardize the layout. If the series contains the
same background data, you can include that data in the template. Using a template can save you time
since you don’t have to manually reproduce the common parts of the maps. You can also use the map
templates that come with ArcMap to quickly make a decent looking map, with a minimal amount of
layout work on your part. Just choose a template that has the look you want, add your data, and make
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whatever changes you want, and your map is done.

Starting a map from a template: Map templates make it easy to reuse the same layout or even the
same data on a series of maps. You can use the templates that come with ArcMap to make maps
quickly—all you need to do is add data, a title, and any other supporting information that you choose.
When you open a template, you get a new untitled ArcMap document plus any layout or data that’s
saved in the template.

Opening a template when you first start ArcMap

1. Start ArcMap. S
2. Click Start using ArcMap with A template. P e

3. Click OK. ] oo iy e

4. Click a template. 0—&— =

5. Click OK. L s i o

L—‘ﬁgrkmm

i ] -
3F arvpiedd oo \Clarb Coraniyl srdine ed
anpiold ke d onc T e el
5 el e ik E o

S, e gt S outhE &

F Iﬂumﬂwﬁ‘:‘;ww E-_e

EN ST e = i
Gt o _—rl#
o

Opening a new template while in ArcMap

1. Click File and click New.

. . D Crl-+M

2. Click a template and click = Open.. et

OK. = Save Ctrl+S
Save &s

Saving a map as a template:_If you create a map that you'd like to use as a template, or if you
modify an existing template and want to use it again, you can save it as a template. You can save a
map template anywhere on your network. When you want to use the template, you can open it from
ArcCatalog or ArcMap. If you save a template in the ArcMap Templates folder (by default in the folder
\Bin\ Templates where you’ve installed ArcGlS), it will show up in the list of templates on the New map
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document dialog box. You can also create subfolders in this folder, and they’ll show up as separate tabs
on this dialog box—when you click each tab you’ll see the templates in that folder. If you work with
many different templates, this is a great way to organize them.

Saving a template

1. Click File and click Save As. Flo &l View [nset Selsction Tocks Window Hebp
2. Click the Save as type dropdown arrow and 1D hew CtleN
click ArcMap Templates. & Open.. Chika

3. Navigate to the folder where you want the M save

template saved.
4. Type a name for the new template.

5. Click Save. 3
Save As EHE

NOTE: You can only save a map as a Savein | Torglaie: | eaom-
template if your map was built using g E::::ﬁf::."n':.r.
Normal.mxt as the base template. If it 1 ward &potrathecerninset ot

’ . . . M andscapeClassc mot
wasn’t, click the Edit menu and click Select e E——
All Elements while in layout view. Then copy %liﬁf.ah;f:
and paste the elements into a new empty MLt
map. Then you can save the new map as a T — w10
template o perepm—— ] omes |

1]
0 o
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Saving a template so it will appear in a new tab

1. Click File and click Save As. Fle EGl Viow luedt Selcton Took Window Heb
2. Click the dropdown arrow and click ArcMap D ew ol
@ Qo Cib)
Templates. B e T
3. Navigate to the Templates folder.

H

. Click the New Folder button.
5. Type the name of the new folder—this name
will appear on the New map document

. Somi| i Tglies | d ey
dialog box as a tab. _,-_..,,:.J e ——
6. Double-click the new folder. el %ﬁ;’,i::;!ﬁ:'._.m
7. Type the name of the new template. ———— Y
8. Click Save. i
Next time you start a map from a template, BRI e sive =]
you’ll see a new tab with your template Sovmnga [lcsie Tengte v . i |
on the New map document dialog box é
0
[
WEtamti S| e 1591 o oess O
T ' S Jetod
Flarame  [iraieloes! mpiee 1 [ j——o
S maypa [iocbtc Tonistes | | :_j Carcal I !
7]

Switching to layout view

1. Click View and click Layout View. B Do View r| | =
OR O 9 G

. . Zoom Diata
Click the Layout View button on the bottom - —

left corner of the map display area. Bockmaks
Locks:
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Setting up the page size and printer properties

. Right-click the virtual page and click Page
and Print Setup.

You can also open the Page and Print Setup
dialog box from the File menu or the Print
dialog box

. Click the Name dropdown narrow and click
the printer you want to use.

. Click the Paper Size dropdown arrow and
click the page size that’s right for your map.

. Click OK.

Because the Use Printer Paper Settings box is
checked, the map Width and Height text
boxes are updated with the new page size,
and the Page Orientation is set accordingly

ArcGIS Basic
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Righi-click outside the selected data
frames to get the Page context manu

Frtem e
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Check to automatically rescale
map elements when you change
the page size,

Making the map page size independent of the system printer

. Uncheck Use Printer Paper Settings on the
Page and Print Setup dialog box.

. Click the Standard Sizes dropdown arrow and
click the page size that’s right for your map.

. Optionally, to define a custom page size,
type the page size for your map in the Width
and Height text boxes.

. Click OK.

i i
L
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Setting the page orientation

1. On the Page and Print Setup dialog box, click
a Paper or Page Orientation (Landscape or
Portrait) to set the page orientation.

2. Click OK.

Showing or hiding printer margins

1. Check Show Printer Margins on Layout in the
Page and Print Setup dialog box.
2. Click OK.

Renaming a data frame

1. Click the data frame in the table of contents.
2. Wait a moment, then click the data frame a
second time.

3. Type a new name for the data frame.
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R o]

o
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Adding a border to a data frame

1. In the table of contents, rightclick the data
frame and click Properties.

2. Click the Frame tab.

. Click the Border dropdown arrow and click a
symbol.

4. Click the Color dropdown arrow and click a

color.

ArcGIS Basic

S Corwent Famurms w frphacs
kv
o

[ ]

Click here to change other
border properties,

5. Type an X and Y gap to offset the border

from the edge of the data frame.
6. Type a Rounding percentage to round the »G,:'..:nrlmu'f?;nfn.;.“fw ! oo sl intonct
corners of the border. o
7. Click OK. [ =my
O« e[ 3m ([ m s [ 71

Bach g
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CEN e P e N e

Dviop Sancionss

—
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Adding a background to a data frame

Click here to change other
background properties.

1. In the table of contents, rightclick the data
frame and click Properties.

2. Click the Frame tab.

3. Click the Background dropdown arrow and

Genwa | DataFram | 0 Spees || Mminaton | Gas |
Arnotsnon Googs | EsernAooanges  Frome | MapCache | Sae and Possan

Bordn

click a background. [ = =i
4. Click the Color dropdown arrow and click a oo 5[ Fm ¢t m perap[Fs
color. Wﬁ 3—a o
5. Type an X and Y gap to offset the background O — = w1 rarss [ s 6 )
from the edge of the data frame. ey

6. Type a Rounding percentage to round the
corners of the background.
7. Click OK.
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Adding a drop shadow to a data frame

1. In the table of contents, rightclick the data Srl:jr-;': hﬁai for c;rb;'-;ifhzgfer
frame and click Properties.
2. Click the Frame tab. mﬂ#ﬂg
3. Click the Drop Shadow dropdown arrow and e oo evee
click a drop shadow. 1 o |
4. Click the Color dropdown arrow and click a o MEL B WL
color. 1 e
5. Type an X and Y offset to shift the drop T T e s =4
shadow away from the border of the data r'“‘"“‘“ —L o
frame. O &% TI..,,._;]_‘ WE‘ o
6. Type a Rounding percentage to round the ——
corners of the drop shadow.
7. Click OK —

Turning rulers on and off

2. Point to Rulers and click Rulers.

1. Right-click the page. ? Auler 0
The rulers are on by default. ||- | Pos i s

il e Lot
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Snapping to rulers

1. Right-click the page. 1 P it sk

R Orgs i
2. Point to Rulers and click Snap to Rulers. ETAUA I
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Setting the units and divisions on rulers

1. Right-click the ruler.

2. Click Options.
If the ruler is not showing in your layout
view, then click Tools on the Main menu,
click Options, and click the Layout View tab.

3. Click the Units dropdown arrow and click a
unit of measure.

4. Click the Smallest Division dropdown arrow
and click the size of the smallest division.

5. Click OK.

Turning guides on and off

1. Right-click the page.
2. Point to Guides and click Guides.
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Snapping to guides
1. Right-click the page. Pt
2. Point to Guides and click Snap to Guides. E) Lo Dt
When you move map elements to the :fmu--an—-
vicinity of a guide, the map element will s
snap to the guide. - f
F.;m
;: "
Adding a guide
1. Click the ruler at the location where you B ki
want to add a guide. It doesn’t have to be et
exact, because you can move the guide. I 6 é?J IG
Guide
Moving a guide
1. Point to a guide marker on the ruler. Your ?
pointer will change. IS E EY 1= . 1=
2. Click and drag the guide marker to a new ' i
location on the ruler.
The guide appears with a dotted line until
you release the mouse button.
Removing a guide
1. Point to a guide marker on the ruler. Your ?
pointer will change. 7 B - 3
2. ng.ht-cllck the guide marker and click Clear -+ - = & —_— -
Guide
- SetGude —_—
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Removing all guides from a ruler

1. Right-click the ruler.
2. Click Clear All Guides. All of the guides are
removed from the ruler.

Using guides to define a map’s margins

1. Click the rulers to add guides where you
want the map’s margins to be.

2. Optionally, move the guides to fine-tune
their position

Turning the grid on and off

1. Right-click the page.
2. Point to Grid and click Grid.

Snapping to the grid

1. Right-click the page.
2. Point to Grid and click Snap to Grid.
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Changing the grid size

1. Click Tools and click Options.

2. Click the Layout View tab on the Options
dialog box. The Options dialog box appears.

3. Click the Horizontal Spacing dropdown arrow
and click a number of units to specify the
horizontal spacing of the snapping grid.

4. Click the Vertical Spacing dropdown arrow
and click a number of units to specify the
vertical spacing of the snapping grid.

5. Click OK

Changing the snapping tolerance

1. Right-click the page.

2. Click Options.

3. Type a number of units for the snapping
tolerance.

4. Click OK.
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Adding a new data frame to a map

1. Click Insert on the Main menu and click Data
Frame. You can add any data to the new data

frame.

ArcGIS Basic

Existing data frame

|!-

Duplicating a data frame

w

. In Layout View, click the data frame to select

it.

. Click Edit and click Copy.

. Click Edit and click Paste.

. Click the copy, located on top of the original
data frame, and drag it to a new place on the

page.

Newly inserted

i B - - -
data frame
T [T T —
N =l
B = —=n
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Resizing a data frame

1. Click the data frame to select it. Q

2. Click a selection handle and drag it to change I L 1P =
the size of the data frame. Hold Shift while 1 (T g [e—=—
resizing to maintain a 1:1 size ratio.

Ll |9

}ﬁ%
[
5@

-ol-nl-?;l | _~l;| o) &4 | ;Iﬂ

Using one data frame to show the location of another

4. Click the detail data frame (in this case called
My Data Frame) in the Other data frames list
and click the right arrow button to send it to
the Show extent rectangle for these data
frames list.

5. Click Frame to choose a border for the extent
rectangle

6. Click the Border dropdown arrow and click a
border.

7. Click OK on the Frame Properties dialog box.

8. Click OK on the Data Frame Properties dialog
box.

1. Click the overview data frame to select it. Overview data frame
2. Right-click the overview data frame and click . — _____l____ﬂ
Properties. . ;

. | £ cu IOl

3. Click the Extent Rectangles tab. A B o o

¥ Deisis Dislete

* T w w w w
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Overview data frame

Extent rectangle
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Adding a North arrow

1. Click Insert and click North Arrow.

2. Click a North arrow.

3. Click OK.

4. Click and drag the North arrow into place on
your map.

5. Optionally, resize the North arrow by clicking
and dragging a selection handle.
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Adding a scale bar

1. Click Insert and click Scale Bar. [Insest Selection Took
2. Click a scale bar. 5 DalaFrame
3. Optionally, click Properties to modify the f‘ :"’
scale bar’s properties. N::h
4. Click OK. L
5. Click and drag the scale bar into place on '; Nmm;u"
your map. -y O
6. Optionally, resize the Scale bar by clicking i Scale Text .
and dragging a selection handle. bR E
Fivam. 1
If you resize the width, the distance BNAN e B
measures along the scale bar are Scde Line N—
recalculated. If you resize the height, the L ifmm =
height of the bar is altered and the text size e
is altered accordingly. ﬁi""ﬁ“:*
[RERE) |hiles
024 B
Shapped Scals Lire I
LTRE- ThI Vi T e VU W 1)
1]
Ehries e 1 pe. O
(NN .
00 0 30 40 i G I
2 berising Soos D 2 I e 3
1l i ||»|_J ® | Cexe I
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Customizing a scale bar’s scale and units

1. Right-click the scale bar and click Properties. ?
2. Click the Scale and Units tab. Altermating Scale Bar Properties (713
3. Click the arrow buttons to set the Number of Scale and Urits | Numbers and Marks | Feman | Frame | Size and Pastion
divisions. oy ——=
4. Click the arrow buttons to set the Number of S o 3
subdivisions. i s = o
5. Click the When resizing dropdown arrow and I st aas Sk ke
click how you want the scale bar to respond When ssizing
when the map scale changes. =T E o
Adjust division value—the division value will ' ::;u,,.
vary with the map scale. The number of [Kometess - L6 ]
divisions and the width of the scale bar IL:HF:M 3
rerT1a|n constant. . o s O
Adjust number of divisions—the number of e
divisions will vary with the map scale. The
division value and the width of the scale bar
remain constant. B S S

Adjust width—the width of the scale bar will 0
vary with the map scale. The division value
and number of divisions remain constant.
6. Choose the units for the scale bar.
7. Click Symbol and choose a text style for the
scale bar labels.
8. Click OK.
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Customizing a scale bar’s numbers and marks

N

. Right-click the scale bar and click Properties.
. Click the Numbers and Marks tab.
. Click the Numbers Frequency dropdown

arrow to choose where along the bar to
place the numbers.

. Click the Numbers Position dropdown arrow

to choose where to place numbers relative
to the bar.

. Click the Marks Frequency dropdown arrow

to choose where along the bar to place tic
marks.

. Click the Marks Position dropdown arrow to

choose where to place tic marks relative to
the bar.

. Click the Division Height arrow buttons to

increase or decrease the height of division
tic marks.

. Click the Subdivision Height arrow buttons to

increase or decrease the height of
subdivision tic marks.

. Click OK.

2

Aternaling Scale Bar Properties

ArcGIS Basic
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Adding scale text
1. Click Insert and click Scale Text. T i
2. Click a sample of the style of scale text to £ Dot Frame
add to the map. b The
. . . . A Tes
3. Optionally, click Properties to customize the ey
scale text. 3 ogend.
4. Click OK. B Hoth Ariow,
wn Seals B
. Click and drag the scale text into position on g .
your map. @ P
. Optionally, resize the scale text by clicking _es |

and dragging a selection handle T ——

P
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Adding a legend

1. Click Insert and click Legend.

The Legend Wizard appears. If you don’t see
it, enable the Legend Wizard as described in
the tip to the left.

2. By default, all the layers on the map will
appear as legend items in the legend.

To remove a legend item, click it, and then
click the left arrow button.

3. Use the up and down arrow buttons to order
the legend items.
4. Click Next.

5. Type a title for the legend.
6. Set the text color, size, and font as desired.
7. Click Next.

[Inset Selection Tools
i=F [Data Frame
A Tes
[ Meatine
O
f] Nosth Anow,

= Scale Bar,
E= Scale Test.
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8. Click the Border dropdown arrow and click a
border.
9. Click the Background dropdown arrow and
click a background.
10. Click the Drop Shadow dropdown arrow
and click a drop shadow.
11. Click Next

12. Click a Legend Item in the list to modify the
symbol patch.

13. Set the Patch properties as desired.

14. Click Next.

15. Set the Spacing between legend elements
by typing a value into the appropriate box.

16. Click Finish.
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Changing the patches in a legend

1. Double-click the legend on the map to open
the Legend Properties dialog box.

2. Click the Legend tab.

3. Click the dropdown arrow to select a new
patch shape.

4. Click OK.

Changing the items in a legend

1. Right-click the legend on the map and click
Properties.

2. Click the Items tab.

3. Click a legend item in the Legend Items list.

4. Click the up and down arrows to move the 4]
item up or down in the legend. ’5)
5. Optionally, click Style and change the Item’s 0
style in the legend. '7]
6. Optionally, check Place in new column to ap Cormackon
. . . . 7 Drdy disgley the legerd inms et have deta viible on fhe map
place the highlighted item in a new column. 7 Ak o o gl g R

W Remder ihe legend sems when e map pern ae isodsed

7. Optionally, change the number of columns in
the legend for the highlighted legend item by
clicking the up and down arrow keys. o ]| e | b |

8. Optionally, remove an item from the legend
by clicking it and clicking the left arrow key. o

9. Click OK.
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Framing a map element

1. Right-click the element on the map and click
Properties.

2. Click the Frame tab.

3. Click the Border dropdown arrow and click a
border.

4. Click the Background dropdown arrow and
click a background.

5. Click the Drop Shadow dropdown arrow and
click a drop shadow.

6. Click OK.
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Converting map elements to simple graphics

1. Right-click an element, such as a legend, and

click Convert To Graphics.
The element is now a grouped graphic.
2. Right-click the graphic and click Ungroup.

The individual graphics that comprise the
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Adding a graticule

1.

O 00 N O U1 b~

. Click Graticule.

. Type a name for the new grid.
. Click Next.

. Click an Appearance option.

. Type the Intervals you want.

. Click Next.

In the table of contents, double-click the
data frame for which you want to add a

appear. If not, see the tip to the left.

graticule. et | Do | oo | Hiue | mesinl
. Click the Grids tab on the Data Frame L L T T e,
Properties dialog box.
. Click New Grid.
The Grids and Graticules Wizard should =
T (e s s by ks e st —-——‘ ’
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10. Check the Axes you want and set how they
should appear.

11. Click the Font button beside Text Style to
set the text style.

12. Click Next.

13. Click the Graticule Border you want.

14. Check Place a border outside the grid.

15. Click to specify whether the graticule is
static or updates with changes to the data
frame.

16. Click Finish.
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Adding a measured grid

0N O Ul b

9.

. In the table of contents, double-click the

data frame you want to add a measured grid
to.

. Click the Grids tab on the Data Frame

Properties dialog box.

. Click New Grid.

The Grids and Graticules Wizard should
appear. If not, see the tip to the left.

. Click Measured Grid.

. Type a name for the new grid.

. Click Next.

. Click an Appearance option.

. Click Properties to set a coordinate system

for the grid that differs from that of the data
frame.
Type the Intervals you want.

10. Click Next.
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11. Check the Axes you want and set how they
should appear.

12. Click the Font button beside Text Style to
set the text style.

13. Click Next.

14. Click the Measured Grid Border you want.

15. Check Place a border outside the grid.

16. Click to specify whether the measured grid
is static or updates with changes to the
data frame.

17. Click Finish.

ArcGIS Basic
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Adding a reference grid

1. In the table of contents, double-click the
data frame you want to add a reference grid
to.

2. Click the Grids tab on the Data Frame

Properties dialog box.

. Click New Grid.

The Grids and Graticules Wizard should
appear. If not, see the tip to the left.

4. Click Reference Grid.
. Type a name for the new grid.
6. Click Next.
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7. Click an Appearance option.
8. Type the Intervals you want.
9. Click Next.

10. Set the Tab Style.

11. Set the Tab Configuration.

12. Click Next.

13. Check Place a border between grid and axis
labels.

14. Check Place a border outside the grid.

15. Click to specify whether the graticule is
static or updates with changes to the data
frame.

16. Click Finish.

147 Comprehensive Disaster Management Programme (CDMP II), DMRD, MoFDM



Adding a title

1. Click Insert and click Title.

2. Type a title for the map.

3. Click and drag the title into place on your
map.

4. Optionally, modify the appearance of the
title text

ArcGIS Basic

Modifying a title

1. With the title selected, click the Font
dropdown arrow and click a font in the Draw
toolbar.

2. Click the Font Size dropdown arrow and click
a font size.

3. Click Bold, Italic, or Underline to change the
style of the text.

4, Click the Text Color dropdown arrow and
click a color

Adding a graphic element

1. Click the graphics dropdown arrow on the
Draw toolbar.

2. Click the New Rectangle button.

3. Click the map and drag a box where you
want the rectangle.

The graphic element appears on the map
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Applying color to a graphic element

1. Click a graphic element to select it.

2. Click the Fill Color dropdown arrow on the
Draw toolbar.

3. Click a color.

The fill color is applied to the graphic element.

Applying a line color to a graphic element

1. Click a graphic element to select it.

2. Click the Line Color dropdown arrow on the
Draw toolbar.

3. Click a color.

The line color is applied to the graphic element.

EENENCNCINNEN
FEEENIENEEER
EEENNNENEEEN
REN00000EmmA
RROC0O000mMmER
BEEEOCOIENER
EEEEEEENEEER

Mere Colors,,,

Na Colot

L PR L B TE R B P
OEmOO00OEeN
| JI:I_:DUI_.---.
OEEE fEIEEEN
FEEESTENEEEEER
..l.!....l..

REDOOOOCDE @ @EE

BEDOOCCOOCOEENE

EREEOCCDD0DEmEE

EEEENEEEEEENRE
Moee Colors,

Placing a graphic element behind other elements

1. Click the graphic element to select it.
2. Right-click the graphic element, point to
Order, and click Send to Back.
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Dislittaite » [@ Send Backwad
Rotate or Fip 3

[5' Propetties.

Graphic rectangle =i
behind map elements
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Adding a neatline

1. Click the Insert menu and click Neatline. |inset Selection Tocls
2. Click the Placement option you want. £# Data Frame
3. Check Group neatline with element(s) if you fg) Thle

want to group the elements with the ATt

neatline. ] teatve . R4
4. Click the Border dropdown arrow and click {3 Legend..

the type of neatline you want. £} Nodhviow..

. = Scale Bar .
5. Click OK I ——
[} Picture..,
Object .

o rosuny ||[m—
G Foundeg

Adding a picture

1. Click Insert and click Picture.
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2. Navigate to the folder that contains the
picture.

3. Optionally, select the type of picture that
you want to add.

4. Click the picture that you want to add.

5. Click Open.

6. Click and drag the picture into position on
your map.

7. Optionally, resize the picture by clicking a

selection handle and dragging it.

Aligning map elements

1. Click one of the map elements to select it.
2. Hold the Shift key and click the other map

element. Now both elements are selected.

3. Right-click one of the selected elements,
point to Align, and click Align Center.

4. Click the aligned map elements and drag
them into position on your map
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Grouping map elements

1. Click one of the map elements to select it.
2. Hold the Shift key and click the other map
element.
Now both elements are selected.
3. Right-click one of the selected elements and

< 4 Ot
click Group. B2 Coy [ s
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Previewing and printing a map
1. Click File and click Print Preview. B 680 Yom fruert Soecten Tooh Wedow teb
2. Examine the preview. If it looks right, click g""'“" e
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3. Verify that you’re printing to the correct
printer with the printer engine you want.

4. Optionally, click the Setup button to display
the Page and Print Setup dialog box and
choose another printer engine. Click OK.

5. Click OK.

Changing the layout

1. Click the Change Layout tool on the Layout
toolbar.

2. Click the tab containing the template you
want to use to change the layout.

3. Click the template you want to use.

4. Click Finish if the number of data frames on
the map matches the number of data frames
in the template.

Click Next if the number of data frames on
the map doesn’t match the number of data
frames in the template and proceed to the
next step to arrange the data frames on the
map.

5. Click the data frame you want to position on
the map.

6. Click Move Up or Move Down to change its
position in the list.

Order the data frames to position them
appropriately on the layout. If your map has
more data frames than the template
provides space for, the extra data frames will
be positioned at the lower-left corner of the
map.

7. Click Finish
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Exporting a map

. Click File and click Export Map. B £t wew [rsert Selection Tocks Wrdow iee
Navigate to where you want to save the e .
) & y & gpen., cho
export file. & s s
. Click the Save as type dropdown arrow and s
click the type of file that you want to export. » ::‘MM .
. Type a name for the export file. | Pamsep..,
. Optionally, click the arrow to expand the %mm
Options and set the parameters for the file ﬁ,:
type that you chose. Tl
. Click Save
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